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1 . INTRODUÇÃO

Parabéns! Adquiriu um sistema de treino completo, que pode ser adaptado às suas necessidades de

treino. Este manual do utilizador inclui instruções completas sobre como tirar o melhor partido do seu

computador de corrida.

2 . COMPONENTES DO COMPUTADOR DE CORRIDA

1. Computador de Corrida Polar RS400/RS800: O computador de corrida exibe e grava a sua

frequência cardíaca e outros dados do exercício durante o mesmo.

2. Transmissor Polar WearLink® 31(Polar RS400) ou Polar WearLink® W.I.N.D. (Polar RS800): O

transmissor envia o sinal da frequência cardíaca ao computador de corrida. O transmissor é

constituído por um conector e por uma tira elástica.

3. Sensor de pé Polar S1 foot pod
TM

(Polar RS400): Este sensor transmite a velocidade/ritmo e as

distâncias ao computador de corrida.

4. Sensor de passada Polar Stride Sensor
TM

s3 W.I.N.D. (Polar RS800): Este sensor transmite a

velocidade/ritmo e as medições de distâncias ao computador de corrida. O sensor também mede a

cadência de corrida e a extensão da passada.

5. CD-ROM: O CD inclui o Polar ProTrainer 5
TM

e a versão completa do manual do utilizador, para o

ajudar a tirar o melhor partido do seu computador de corrida.
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3 . INICIAR

Definições Básicas

Antes de começar a fazer exercício com o computador de corrida, personalize as definições básicas.

Introduza dados tão precisos quanto possível para garantir uma resposta correcta do equipamento,

baseada nos seus parâmetros pessoais.

Para seleccionar os valores, prima UP e DOWN, e para os aceitar prima OK. Percorra os valores mais

rapidamente premindo UP ou DOWN sem libertar.

1. Para activar o seu computador de corrida, prima OK duas vezes.

2. É exibida a mensagem Welcome to the Polar Running World! (Bem-vindo ao Mundo de Corrida da

Polar!). Prima OK.

3. Language (Idioma): Seleccione English (Inglês), Deutsch (Alemão), Español (Espanhol) ou Français

(Francês).

4. É exibida a mensagem Start with basic settings (Comece pelas definições básicas). Prima OK.

5. Time (Hora): Seleccione 12h ou 24h. No modo de 12h, seleccione AM ou PM. Introduza a hora local.

6. Date (Data): Acerte a data: dd = dia, mm = mês, yy = ano.

7. Units (Unidades): Seleccione unidades métricas (kg/cm/km) ou imperiais (lb/ft/mi).

8. Weight (Peso): Introduza o seu peso. Para mudar as unidades prima LIGHT, sem libertar.

9. Height (Altura): Introduza a sua altura. Se está a utilizar unidades imperiais, indique primeiro os

pés (ft) e depois as polegadas (in).

10. Birthday (Data de nascimento): Introduza a sua data de nascimento: dd = dia, mm = mês, yy =

ano.

11. Sex (Sexo): Seleccione Male (Masculino) ou Female (Feminino).

12. É exibida a pergunta Settings OK? (Definições OK?). Seleccione Yes (Sim): As definições são aceites

e guardadas. O computador de corrida exibe a hora. Seleccione No (Não) se as definições

estiverem incorrectas e necessitarem de ser alteradas. Prima STOP para voltar aos dados que

pretende alterar.
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Estrutura do Menu

4 . PREPARAR PARA O TREINO

Colocar o transmissor

Para medir a frequência cardíaca necessita de utilizar o transmissor.

1. Humedeça os eléctrodos da tira com água.

2. Fixe o transmissor à tira elástica. Aproxime a letra L do conector da palavra LEFT da tira, e

encaixe. Ajuste o comprimento da tira de forma que fique confortável. Passe a tira à volta do

peito, logo abaixo dos músculos peitorais, e encaixe o transmissor.

3. Verifique se os eléctrodos humedecidos ficam em contacto total com a pele e se o logotipo Polar

do conector fica centrado e na vertical.

4. Desaperte a tira depois de fazer exercício aplicando pressão com o polegar e o indicador e rode

como se ilustra na figura.

O transmissor Polar WearLink pode ser usado com vestuário específico, que possua eléctrodos têxteis
incorporados. Humedeça as zonas do vestuário com eléctrodos. Aplique o conector do transmissor
directamente ao vestuário, sem a tira, de modo que o logotipo Polar do conector fique direito.
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Colocar o Polar s3 Stride Sensor W.I.N.D.

Instalar a Pilha do Sensor de Passada

Antes de utilizar o sensor de passada* pela primeira vez coloque a pilha (incluída na embalagem do

produto).

1. Retire a tampa do compartimento da pilha rodando-a no sentido retrógrado, na direcção de OPEN

(Abrir), usando o garfo do sensor ou uma moeda (ver figura 1).

2. Coloque a pilha dentro da tampa, com o lado positivo (+) voltado para a tampa (ver figura 2).

Verifique se o anel vedante está colocado na ranhura, para garantir a resistência à água.

3. Coloque a tampa no sensor, mantendo a pilha no seu interior.

4. Exerça pressão na tampa, com esta colocada, e feche-a rodando no sentido directo, de OPEN

(Abrir) para CLOSE (Fechar), usando o garfo do sensor ou uma moeda.

O sensor de passada pode ser posicionado nos atacadores ou num compartimento existente na sola de

determinados sapatos de corrida.
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Aplicar o Sensor de Passada nos Atacadores

1. Desencaixe a aba e retire o garfo.

2. Folgue os atacadores e enfie o garfo entre estes e a lingueta do sapato. Aperte os atacadores.

3. Encaixe a parte da frente do sensor no garfo e pressione a partir de trás. Encaixe a aba.

4. Verifique se o sensor de pé não oscila e fica alinhado com o pé. Quanto mais fixo ficar o sensor

maior será a precisão das medições da velocidade e da distância.

Aplicar o Sensor de Passada no Compartimento da Sola

1. Desencaixe a aba e retire o garfo.

2. Levante a palmilha. Coloque o sensor no compartimento da sola, mantendo o logotipo Polar virado

para cima e a parte de trás do sensor virada para o calcanhar do sapato. Repare que o sensor só

pode ser colocado com uma orientação sem forçar.

A calibração do sensor, que é facultativa, pode melhorar a precisão das medições da velocidade, ritmo e
distância. Para obter mais informações consulte Calibrar o Sensor de Passada.

*É necessário utilizar o sensor de passada s3 stride sensor W.I.N.D. vendido separadamente.

Calibrar o Sensor de Passada

A calibração do sensor, que é facultativa, melhora a precisão das medições da velocidade, ritmo e

distância*. Recomenda-se que calibre o sensor antes de o usar pela primeira vez, se houver alterações

significativas no seu estilo de corrida ou se mudar radicalmente a posição do sensor no sapato (e.g. se

usar sapatos de corrida novos). Pode calibrar o sensor correndo uma distância conhecida ou regulando

o factor de calibração manualmente.
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Calibrar o Sensor Correndo uma Distância (calibração rápida)

Pode calibrar a sensor em qualquer fase do exercício, com correcção da extensão da volta, se não se

estiver a exercitar com objectivos baseados numa distância. Corra uma distância conhecida, de

preferência mais de 1000 metros.

Verifique se a função sensor está ligada no computador de corrida:

Seleccione Settings > Features > S Sensor (Definições > Características > Sensor de Passada)

No modo da hora prima OK duas vezes e comece a correr.

Corra uma volta com uma distância conhecida. Pode calibrar a sensor durante quaquer uma das voltas

da sua corrida. Quando terminar a volta proceda à calibração seleccionando uma das duas alternativas:

1. Pare, permaneça imóvel e prima LIGHT para passar às Definições. Ou,

2. Pare, permaneça imóvel e prima STOP uma vez. Seleccione Settings (Definições).

Seleccione Calibrate > Correct lap > Set true lap distance (Calibrar > Corrigir volta > Definir verdadeira

extensão da volta). Defina a extensão da volta que acabou de efectuar e prima OK.

São exibidos a indicação Calibration complete (Calibração completa) e o factor. O sensor está agora

calibrado e pronto a funcionar.

Definir o Factor de Calibração Manualmente

O factor de calibração é calculado como a razão entre a distância real e a distância não calibrada.

Exemplo: correu 1200m, o computador de corrida indica uma distância de 1180m, o factor de

calibração é 1,000. Para calcular o novo factor de calibração temos: 1,000*1200/1180 = 1,017. O

intervalo de medição do factor é de 0,500-1,500.

Pode definir o factor de calibração de quatro formas:

1. Antes do exercício.

Seleccione Settings > Features > S sensor > Calibrate (Definições > Características > Sensor de Passada >

calibrar)

Defina o Factor de calibração (Calibration factor) e prima OK. O sensor está agora calibrado.

2. Depois de iniciar a medição da frequência cardíaca e antes de gravar o exercício.

No modo da hora seleccione OK > Settings > Footpod > Calibrate (Definições > Sensor de Pé > Calibrar)

Defina o Factor de calibração (Calibration factor) e prima OK. O sensor está calibrado e pode começar a

gravar o exercício premindo OK.

3. Durante o exercício, fazendo uma pausa na gravação do exercício.

Comece o exercício premindo OK duas vezes no visor da hora. Prima STOP uma vez para efectuar uma

pausa na gravação do exercício.

Seleccione Settings > Calibrate > Set factor (Definições > Calibrar > Definir Factor)

Defina o Factor de calibração (Calibration factor) e prima OK. O sensor está agora calibrado. Continue a

gravar o exercício premindo OK.

4. Durante o exercício, sem fazer pausa na gravação do exercício.

Comece o exercício premindo OK duas vezes no visor da hora. Prima LIGHT sem libertar, para

seleccionar Settings (Definições).

Seleccione Calibrate > Set factor (Calibrar > Definir Factor).

Defina o Factor de calibração (Calibration factor) e prima OK. O sensor está agora calibrado. Continue a

correr

Se visualizar a mensagem S sensor calibration failed (Falha na calibração do sensor S), o sensor não foi
calibrado e terá de tentar novamente.
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*É necessário utilizar o sensor de passada s3 stride sensor W.I.N.D. vendido separadamente.

Planifique o seu Treino

Tipos de Exercícios

O seu computador de corrida permite-lhe utilizar exercícios que já estão programados ou criar novos

exercícios. Também pode criar exercícios mais versáteis e transferi-los para o seu computador de

corrida, utilizando o Polar ProTrainer 5 .

Seleccione Settings > Exercise (Definições > Exercício).

O menu Exercício exibe uma lista de exercícios. Navegue pelas opções premindo UP ou DOWN e

visualize o exercício premindo OK.

• Free (Livre): Exercício livre, sem definições predefinidas.

• Basic (Básico): Treino básico, de intensidade moderada. Duração de cerca de 45 min.

• Interval: (Intervalado) Treino básico intervalado. O exercício começa com um aquecimento de 15

minutos, seguido de um intervalo de 1km e de um período de recuperação de 3 minutos, repetidos

5 vezes. A sessão termina com um arrefecimento de 15 minutos.

• OwnZone: Exercício básico baseado na OwnZone, de intensidade moderada. Duração sugerida, 45

minutos. O computador de corrida consegue determinar automaticamente a sua zona de frequência

cardíaca durante o exercício aeróbico (cardiovascular). Esta funcionalidade é designada por

OwnZone. Para obter mais informações, consulte Determinar a Sua OwnZone. Poderá encontrar

informações de fundo adicionais em Treinar na OwnZone.

• Add new (Adicionar Novo): Criar e guardar o seu próprio exercício básico. Pode armazenar um total

de 10 exercícios + 1 exercício livre no computador de corrida.

Depois de seleccionar o exercício são apresentadas as seguintes opções. Seleccione a opção

pretendida e prima OK.

• Seleccione o exercício como exercício predefinido. Da próxima vez que treinar, o computador de

corrida apresenta-lhe este exercício como predefinido.

• Visualizar (View) as definições do exercício. Prima UP ou DOWN para visualizar:

1. Exercício básico com 1-3 zonas de exercício: frequência cardíaca alvo ou limites de

velocidade/ritmo* para cada zona, temporizador/distância* para a zona, ou

2. Exercício criado com o software: nome, descrição, tempo alvo do exercício. (Prima LIGHT, sem

libertar, para visualizar as fases do exercício e o perfil de desporto escolhido.)

• Edit Basic (Editar exercício básico) ou efectuar exercício na OwnZone, consoante as suas

necessidades. Também pode editar o exercício criado com o computador de corrida. Para obter

mais informações, consulte Criar Novos Exercícios. Se criou um exercício com fases utilizando o

software, não poderá editá-las com o computador de corrida.

• Rename Basic (Renomear Exercício Básico) Interval (Intervalado) ou de outro tipo com o computador

de corrida.

• Default (Predefinição) - Voltar às definições predefinidas do exercício Básico, Intervalado ou na

OwnZone.

• Delete (Eliminar) o exercício criado com o computador de corrida ou com o software.

Criar Novos Exercícios

Criar um Novo Exercício com Zonas
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Crie os seus próprios exercícios com o computador de corrida. Pode criar exercícios mais diversificados

utilizando o Polar ProTrainer 5. Para obter mais informações, consulte a ajuda do software.

Seleccione Settings > Exercises > Add new (Definições > Exercícios > Adicionar novo)

1. Defina o Number of zones (Número de zonas) do exercício (0-3) e prima OK. Para 0 zonas, consulte

a secção Criar um novo exercício sem zonas.

2. Seleccione Zone type (Tipo de zona):

A. zonas de frequência cardíaca

B. zonas de velocidade/ritmo*

Prima OK. Prossiga, de acordo com a sua escolha.

A. Para as zonas de frequência cardíaca, seleccione zonas de desporto Polar ou zonas manuais de

frequência cardíaca. Prima OK.

• Sport zones (Zonas de desporto): Seleccione uma das zonas de desporto para efectuar exercício (e.g.

Z1: 50-59%). Prima OK.

As zonas de desporto traduzem intensidades da frequência cardíaca, expressas em percentagem da

frequência cardíaca máxima. Por defeito, o computador de corrida tem cinco zonas de desporto

predefinidas: muito ligeira (50-59% FC
máx

), ligeira (60-69% FC
máx

), moderada (70-79% FC
máx

),

intensa (80-89% FC
máx

), e máxima (90-99% FC
máx

). Geralmente, o valor predefinido da FC
máx

é

baseado na idade mas se conhece os seus valores limites aeróbico e anaeróbico, se determinou a sua

frequência cardíaca máxima prevista (FC
máx

-p) através de um Polar Fitness Test
TM

, se testou a sua

frequência cardíaca máxima através de uma prova de esforço, poderá definir as zonas de desporto de

modo que estas se adaptem melhor às suas necessidades de treino.

• Manual (Manual): Defina o limite superior e inferior da zona em bpm ou %FC / %FCR e prima OK.

Continue no passo 3.

B. Se seleccionou zonas de velocidade/ritmo*, defina os limites superior e inferior da zona. Prima OK.

Continue no passo 3.

3. Defina o Guia da zona (Zone guide) para alterar a zona após um determinado tempo ou distância*.

Durante o exercício, o computador de corrida alerta-o sempre que mudar de zona.

• Zone Timer (Temporizador de Zona): Defina o temporizador para a zona (minutos e segundos) e

prima OK, ou

• Zone Distance*(Distância da Zona): Defina a distância da zona e prima OK, ou

• Off (Desactivado): Desactive os temporizadores e as distâncias* e prima OK.

Assim que definir a primeira zona é exibida a indicação Zone 1 OK (Zona 1 OK). Para definir mais de 1

zona de exercícios repita os passos 2 e 3 até definir todas as zonas.

Quando o exercício estiver pronto é exibida a indicação New exercise added (Novo exercício adicionado).

O novo exercício (NewExe) é guardado no menu Exercises (Exercícios), de onde o pode seleccionar na

sessão de exercício seguinte. Renomeie o exercício seleccionando Rename (Renomear) a partir da lista.

Criar um Novo Exercício sem Zonas

Se criar um novo exercício sem zonas poderá usar os temporizadores ou as distâncias* para orientar o

seu treino.

Seleccione Settings > Exercises > Add new (Definições > Exercícios > Adicionar novo)

1. Number of zones (Número de zonas): Defina o número de zonas para 0.

2. Guide type: (Tipo de guia): Active o sinal sonoro de um temporizador durante o exercício (para

lembrar a ingestão de líquidos), ou defina uma distância* (para seguir os tempos das voltas, sem

os gravar).

Temporizadores

• • Number of timers (Número de temporizadores): Escolha o número de temporizadores (1-3) da

sessão. Prima OK.
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• • Timer 1 (Temporizador 1): Defina os minutos e segundos do temporizador e prima OK. Ou

Distâncias*

• Number of distances (Número de distâncias): Escolha o número de distâncias (1-3) da sessão. Prima

OK.

• Distance 1 (Distância 1): Introduza a(s) distância(s) e prima OK.

Repita o passo 2 até definir os temporizadores ou distâncias*. Quando o exercício estiver pronto é

exibida a indicação New exercise added (Novo exercício adicionado). O novo exercício (NewExe) é

guardado no menu Exercises (Exercícios), de onde o pode seleccionar na sessão de exercício seguinte.

Renomeie o exercício seleccionando Rename (Renomear) a partir da lista.

*É necessário utilizar o sensor de passada s3 stride sensor W.I.N.D. vendido separadamente.

5 . TREINO

Iniciar o Treino

Coloque o transmissor e o sensor de passada* de acordo com as instruções. Verifique se activou o

sensor de passada no seu computador de corrida (Settings > Features > S sensor) (Definições >

Características > Sensor de Passada).

1. Inicie a medição da frequência cardíaca premindo OK.

2. Nos 15 segundos seguintes é exibida a sua frequência cardíaca. Mantenha-se de pé e imóvel, e

espere até o computador de corrida captar o sinal do sensor de passada (o símbolo do corredor

deixa de piscar). Para mudar rapidamente o tipo de exercício prima UP, sem libertar. Para mudar

rapidamente o tipo de sapato prima DOWN, sem libertar.

3. Inicie a sessão de exercício premindo OK.

Em alternativa, seleccione Settings (Definições) para alterar ou visualizar as diferentes definições antes

de iniciar o exercício. Para obter mais informações sobre todas as definições disponíveis, consulte

7. Definições.

O menu Settings (Definições) exibe uma lista das seguintes opções:

• Exercise (Exercício): Seleccione um tipo de exercício ou visualize as definições do exercício.

Exercise (Exercício) Seleccione Free (Livre), Basic (Básico), Interval (Intervalado) ou OwnZone. (Se tiver

criado novos exercícios estas opções também serão apresentadas.)

Select (Seleccionar): Define um exercício predefinido que pretenda realizar imediatamente, ou

View (Visualizar): Visualize as definições do exercício.

• Altitude (Altitude): Active, desactive ou calibre a altitude.

• Rec.rate (Frequência de Gravação): Defina a frequência de gravação.

• RR data: (Dados RR): Active ou desactive a gravação dos dados RR.

• TZ Alarm (Alarme da Zona-alvo): Active ou desactive os alarmes sonoros da zona-alvo.

• HR view (Visualização da FC): Seleccione a visualização da frequência cardíaca em batimentos por

minuto (bpm), ou em percentagem da frequência cardíaca máxima (%FC) ou em percentagem da

frequência cardíaca de reserva (%VFC).

• Shoes (Sapatos): Seleccione os sapatos para monitorizar a utilização.

• Speed view (Visualização da velocidade): Seleccione a visualização da velocidade* em quilómetros,

milhas por hora (km/h ou mph), ou em minutos por quilómetro ou por milha (min/km ou min/mi).

• S sensor: ( Sensor de Passada) Active ou desactive a função sensor de passada*.

• A.Lap: Active ou desactive a função volta automática.

• Display (Visor): Modifique o Visor (para obter mais informações, consulte Personalize o Visor do

Computador de Corrida durante o Treino).
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Se for exibida a mensagem: (Nome do exercício), requires S sensor. Turn S sensor on? , ((Nome do exercício)
necessita de sensor de passada. Activar o sensor de passada?), é necessário utilizar um sensor de
passada para o exercício exibir a velocidade/ritmo e a distância* (e.g. se definiu zonas de
velocidade/ritmo* para o exercício). Seleccione Yes (Sim) para activar a função do sensor e verifique se o
colocou de acordo com as instruções. Se for exibida a mensagem Exercise displays updated (Visualizações
do exercício actualizadas) a velocidade/ritmo e a distância* serão apresentados durante o exercício.

*É necessário utilizar o sensor de passada s3 W.I.N.D. vendido separadamente.

Informações no Visor

Durante o exercício, as informações exibidas no visor dependem das definições que efectuou. Percorra

os visores premindo UP ou DOWN. O nome do visor, que apresenta os dados na linha de baixo, é

exibido durante alguns segundos.

Visualizações predefinidas durante o exercício:

Visor da Frequência Cardíaca

Velocidade/ritmo* / calorias

Cronómetro

Frequência cardíaca

Visor do Cronómetro

Calorias

Velocidade/ritmo* / Hora

Cronómetro

Visor da Duração da volta

Apontador de zona

Frequência cardíaca

Duração da volta

Visor da Velocidade/ritmo*

Cadência*

Distância*

Velocidade/ritmo*

Visor da Distância*

Temporizador de contagem decrescente

Apontador de zona

Distância* / Duração da volta

Visor da Altitude

Frequência cardíaca

Subida

Altitude
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Exercício criado com o Polar ProTrainer 5

Se transferiu um programa, pode visualizar os pormenores da sua sessão

de exercício noutro visor. Para obter mais informações, consulte Fazer

Exercício Programado. Não é possível modificar este visor utilizando o

computador de corrida.

Para obter mais informações sobre a personalização de uma visualização, consulte Personalize o Visor

do Computador de Corrida durante o Treino.

*É necessário utilizar o sensor de passada s3 stride sensor W.I.N.D. vendido separadamente.

Símbolos exibidos no Visor

Texto no Visor Símbolo Explicação

Time of day
Hora

Countd. time or Countd. distance
Temporizador de contagem

decrescente ou distância

Lap time
Número da volta e duração da

volta

Lap distance*
Número da volta e extensão da

volta

Stopwatch
Duração total do exercício até ao

momento

Heart rate
Frequência cardíaca actual

Calories
Calorias gastas

Distance*
Distância corrida até ao momento

Speed/pace*
Velocidade/ritmo actual

Zone pointer (heart rate)
Indicador da zona-alvo, com o

símbolo do coração, que se move

para a esquerda e para a direita

dentro dos limites da zona. Se o

símbolo do coração não estiver

visível e/ou soar um alarme, a

sua frequência cardíaca está fora

da zona-alvo.

Zone pointer (speed/pace)
Indicador da zona-alvo, com um

símbolo que se move para a

esquerda e para a direita

consoante a sua

velocidade/ritmo. Se o símbolo

não estiver visível e/ou soar um

alarme, a sua velocidade/ritmo

está fora da zona-alvo.
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Texto no Visor Símbolo Explicação

Zone pointer (Polar sport zones)
Indicador da zona-alvo, com o

símbolo do coração, que se move

para a esquerda ou para a direita

na escala da zona de desporto

consoante a sua frequência

cardíaca. Para obter mais

informações sobre a definição de

uma zona de desporto, consulte

Funções dos Botões durante o

Exercício.

Target zone
Um gráfico que exibe a sua

frequência cardíaca actual

comparada com as zonas de

frequência cardíaca definidas.

RR variation
A variação batida a batida nos

intervalos da frequência

cardíaca, ou seja, a variação nos

momentos entre batidas

cardíacas sucessivas.

Ascent
Ascensão em metros/pés

Altitude
Altitude actual

Cadence*
Cadência de corrida (pares de

passadas por minuto)

*É necessário utilizar o sensor de passada s3 stride sensor W.I.N.D. vendido separadamente.

Funções dos Botões durante o Exercício

Medir uma volta

Prima OK para gravar uma volta. O visor exibe os seguintes dados:

Número da volta

Frequência cardíaca média durante a volta

Duração da volta

Se o sensor de passada* estiver activado também serão exibidos os

seguintes dados:

Número da volta

Extensão da volta

Velocidade/ritmo médio do volta

Bloquear uma Zona

Quando treinar sem zonas-alvo predefinidas poderá bloquear a sua frequência cardíaca na zona de

desporto actual. Deste modo, se não tiver tido tempo para definir zonas-alvo predefinidas antes de

começar o exercício, pode definir rapidamente uma zona-alvo durante a sessão.

Para bloquear/desbloquear a zona prima OK, sem libertar.

Durante os exercícios programados: Prima OK, sem libertar, e seleccione Bloquear zona/Desbloquear

zona (Lock zone/Unlock zone) no menu da Volta (Lap Menu).
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Se, por exemplo, estiver a correr com uma frequência cardíaca de 130 bpm, que corresponde a 75%

da sua frequência cardíaca máxima e equivale à zona de desporto 3, poderá premir OK, sem libertar,

para bloquear a sua frequência cardíaca nesta zona. É exibida a indicação Sport zone3 Locked 70%-79%

(Zona de desporto 3 Bloqueada 70%-79%). Se estiver abaixo ou acima da zona de desporto será

emitido um sinal de alarme (se a função de alarme da zona-alvo estiver activada). Desbloqueie a zona

de desporto premindo novamente OK sem libertar: é exibida a indicação Sport zone3 Unlocked (Zona de

desporto 3 Desbloqueada).

Utilizando o software também pode basear o Bloqueio da Zona na sua velocidade/ritmo*. Para obter

mais informações, consulte a ajuda do software.

Zoom do Visor

Prima UP, sem libertar, para ampliar a linha de cima e DOWN, sem libertar, para ampliar a linha do

meio. Para voltar à visualização normal volte a premir os botões, sem libertar.

Iluminar o Visor (Modo Nocturno activado)

Para iluminar o Visor prima LIGHT durante o exercício. O modo nocturno é activado e o visor

ilumina-se automaticamente quando se prime um botão qualquer ou se muda a fase do exercício.

Visualizar o menu Definições

Prima LIGHT, sem libertar, > Settings (Definições)

É visualizado o menu Settings (Definições) quando se prime LIGHT, sem libertar. No menu definições

pode alterar certas definições sem interromper a gravação do exercício. O conteúdo deste menu varia

de acordo com o tipo de exercício. Para obter mais informações, consulte o 7. Definições.

• Prev. phase (Fase anterior): Visualize um resumo da fase ou repetição anterior (exibido quando se

cria um exercício com fases no software).

• Keylock (Bloqueio de botões): Bloqueie/desbloqueie os botões para evitar premir acidentalmente os

botões.

• TZ Alarm (Alarme da Zona-alvo): Ligue/desligue o alarme da zona-alvo.

• Change zone (Mudar de zona): Active zonas-alvo (exibido se definiu diversas zonas-alvo, excepto

quando utilizar o software para criar um exercício com fases).

• HR view (Visualização da FC): Seleccione o modo de visualização da frequência cardíaca.

• Calibrate (Calibrar): Calibre o sensor de passada* (não é exibido se o sensor de passada* estiver

desligado).

• Seek sensor (Procurar sensor): Procura dados do WearLink e do sensor* de passagem, se o sinal

deixar de ser captado durante o exercício devido a interferências.

• A.Lap*: Activar/desactivar a volta automática.

Uma vez alteradas as definições, o computador de corrida regressa ao modo exercício.

Fazer uma Pausa no Exercício

Faça uma pausa na gravação do exercício premindo STOP.

No modo de pausa pode seleccionar as seguintes opções:

• Continue (Continuar): Continuar a gravar o exercício.

• Exit (Sair): Parar a gravação do exercício (ou premir STOP).

• Summary: Visualizar um resumo do exercício efectuado até ao momento. É visualizada a seguinte

informação resumida: calorias, distância*, duração do exercício, frequência cardíaca, frequência

cardíaca máxima frequência cardíaca média, velocidade/ritmo máximo*, velocidade/ritmo médio*,

subida e altitude.

• Settings (Definições): No modo de pausa também pode alterar as mesmas definições que alterou

durante a gravação, à excepção da personalização do visor, que só pode ser efectuada com o

computador de corrida no modo de pausa.

• Reset (Reinicializar): Eliminar as informações gravadas do exercício. Confirmar com OK e premir

novamente OK para recomeçar a gravar.
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• Free mode (Modo livre): Altere o seu perfil de exercício para exercício livre. Isto não elimina o

exercício realizado, mas continua o exercício sem definições. Se passar ao modo Livre poderá

reiniciar o exercício original fazendo nova pausa no exercício e seleccionando Restart P1 (Reiniciar

P1).

*É necessário utilizar o sensor de passada s3 stride sensor W.I.N.D. vendido separadamente.

Determinar a Sua OwnZone

Para informações básicas sobre a Polar OwnZone®, consulte Treinar na OwnZone.

Determine a sua OwnZone em 1-5 minutos durante um período de aquecimento, enquanto anda a pé

ou faz jogging Deve começar a praticar exercício com pouca intensidade e aumentá-la gradualmente

para aumentar a sua frequência cardíaca.

Redefinir a OwnZone:

• Quando alterar o ambiente ou o modo do exercício.

• Quando voltar a fazer exercício depois de uma paragem superior a uma semana.

• Se não estiver 100% bem, física ou psiquicamente - por exemplo, se não tiver recuperado do treino

anterior, se não se sentir bem ou se estiver stressado.

• Depois de alterar as definições do utilizador.

Antes de começar a determinar a OwnZone, certifique-se de que:

• As suas definições de utilizador estão correctas.

• Seleccionou o exercício OwnZone. Sempre que iniciar o exercício OwnZone o computador de corrida

determinará automaticamente a sua OwnZone.

1. Coloque o transmissor e sensor de passada* de acordo com as instruções. Inicie a medição

premindo OK duas vezes.

2. Quando o exercício começa é exibida a indicação OZ e inicia-se a determinação da OwnZone.

A OwnZone é determinada em cinco etapas. O final de cada etapa é assinalado por um sinal sonoro (se

o som estiver activado).

OZ > Ande a pé, devagar, durante 1 minuto. Mantenha a frequência cardíaca abaixo de 100 bpm /

50% da FC
máx

durante esta primeira etapa.

OZ >> Ande a pé, normalmente, durante 1 minuto. Aumente lentamente a frequência cardíaca em

aproximadamente 10-20 bpm / 5 % da FC
máx

.

OZ >>> Ande a pé, a um ritmo apressado, durante 1 minuto. Aumente a frequência cardíaca em

aproximadamente 10-20 bpm / 5 % da FC
máx

.

OZ >>>> Faça jogging, devagar, durante 1 minuto. Aumente a frequência cardíaca em

aproximadamente 10-20 bpm / 5 % da FC
máx

.

OZ >>>>> Corra a um ritmo apressado, ou corra durante 1 minuto. Aumente a frequência cardíaca em

aproximadamente 10 bpm / 5 % da FC.
máx

.

3. Numa determinada altura da sessão vai ouvir dois sinais sonoros consecutivos. Isto significa que a

OwnZone foi determinada.

4. Se a determinação tiver sido efectuada com êxito, a indicação OwnZone Updated (OwnZone

Actualizada) e a zona são exibidas no visor. A zona é exibida em batimentos por minuto (bpm), em

percentagem da frequência cardíaca máxima (%FC) ou em percentagem da frequência cardíaca

de reserva (%FCR).

5. Se a determinação da OwnZone não tiver sido efectuada com êxito, é utilizada a OwnZone

anteriormente determinada e exibida a indicação OwnZone Limits (Limites da OwnZone). Se a

OwnZone não tiver sido gravada anteriormente, serão automaticamente utilizados limites baseados

na idade.

Por agora pode prosseguir o exercício. Tente permanecer na zona da frequência cardíaca indicada para

maximizar os benefícios do exercício.

Em alternativa, para ignorar a determinação da OwnZone e utilizar a OwnZone determinada

anteriormente, prima OK em qualquer das etapas do processo.
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O tempo utilizado na determinação da OwnZone é incluído no tempo de gravação do seu exercício.

*É necessário utilizar o sensor de passada s3 stride sensor W.I.N.D. vendido separadamente.

6 . DEPOIS DO TREINO

Parar a Gravação

Faça uma pausa na gravação do exercício premindo STOP. Para parar totalmente a gravação, prima

STOP novamente.

Cuide do transmissor após o exercício. Retire o conector da tira elástica depois de o utilizar. Mantenha

o transmissor seco e limpo. Para obter instruções completas sobre os cuidados e a manutenção,

consulte Cuidados e Manutenção.

Analisar os Resultados do Exercício

Para visualizar dados básicos no seu desempenho, consulte o menu File no seu computador de corrida.

Para uma análise mais profunda, transfira os dados para o Polar ProTrainer 5. O software oferece-lhe

diversas opções para analisar os dados.

A ligação entre o computador de corrida e o software é efectuada via IrDA. Primeiro, abra o software.

Depois seleccione Connect no computador de corrida e coloque a unidade de pulso em frente da janela

de infravermelhos do computador. Para obter instruções completas sobre a transferência de dados,

consulte a ajuda do software.

Seleccione File (Ficheiro) para aceder às seguintes opções:

• Exercise log (Diário de exercício): exibe um máximo de 99 ficheiros de exercícios.

• Weekly (Semanal): inclui resumos das últimas 16 semanas.

• Totals (Totais): apresenta dados acumulados do exercício.

• Delete (Eliminar): permite eliminar ficheiros de exercícios.

Diário de exercício

Seleccione File > Exercise log (Ficheiro > Diário de exercício)

No menu Exercise log (Diário de exercício) pode visualizar informações detalhadas sobre as suas

sessões de exercício). São visualizadas as seguintes informações:

• Nome do exercício.

• Uma barra gráfica, que representa uma sessão de exercício. A altura da barra indica a duração do

exercício. Isto mostra a variação gráfica das suas sessões.

• A data em que efectuou o exercício.

As informações visualizadas (seguidamente referidas em a-d) dependem do tipo e das definições do

exercício (e.g. se o exercício não incluir fases, os dados das fases não serão apresentados).

Percorra as barras de exercício premindo UP ou DOWN e prima OK para visualizar:
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a. Basic (Básico)

Seleccione File > Exercise log > Basic (Ficheiro > Diário de exercício >

Básico)

b. Sport Zones (Zonas de Desporto)

Seleccione File > Exercise log > Zonas de desporto (Ficheiro > Diário de

exercício > Zonas de desporto)

c. Phases (Fases)

Seleccione File > Exercise log > Phases (Ficheiro > Diário de exercício >

Fases)

d. Laps (Voltas)

Seleccione File > Exercise log > Laps (Ficheiro > Diário de exercício >

Voltas)

a. Básico

Seleccione File > Exercise log > Basic (Ficheiro > Diário de exercício > Básico)

Nome do exercício

Hora de início

Distance* (Distância*)

Duração

Prima OK e percorra o menu premindo UP ou DOWN para visualizar:

Heart rate (frequência cardíaca) em batimentos por minuto (bpm)

alternando com uma percentagem da frequência cardíaca máxima (%) ou

como uma percentagem da frequência cardíaca de reserva.

Frequência cardíaca máxima

Frequência cardíaca mínima

Frequência cardíaca média

Target zones (Zonas-alvo) (FC / velocidade / ritmo) alternando zona 1, zona

2 e zona 3.

Limite superior

Limite inferior
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Time in, above, and below zone 1/2/3 (Tempo acima, dentro e abaixo da zona

1/2/3) (nome da fase exibida no exercício programado).

Tempo acima da zona

Tempo abaixo da zona

Tempo dentro da zona

Velocidade/ritmo*

Velocidade/ritmo máximo

Velocidade/ritmo médio

Distance (Distância)

Prima LIGHT sem libertar, para comutar a velocidade/ritmo.

Calories : calorias consumidas durante o exercício.

O consumo energético indica o esforço total durante o exercício.

Índice de Corrida

Para obter um valor de Índice de Corrida, o exercício tem de satisfazer

alguns requisitos. Para obter mais informações, consulte Índice de

Corrida Polar.

Altitude

Altitude máxima

Altitude mínima

Altitude média

Subida

Ascensão em metros/pés.

Cadence* (Cadência*) em pares de passadas por minuto

Cadência máxima

Cadência Média.

Stride length* (Extensão da passada*)

Extensão média da passada

Prima STOP para voltar a visualizar as informações básicas.

Informações Básicas Adicionais

Seleccione File > Exercise log > Basic (Ficheiro > Diário de exercício > Básico)

Para adicionar as suas próprias informações sobre o exercício ou para eliminar o exercício do menu File

(Ficheiro) prima LIGHT, sem libertar, quando visualizar a informação básica.

• Rank (Classificação) Atribua uma nota ao exercício.

• Feeling (Sensação): Avalie as suas sensações subjectivas durante o exercício.
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• Temperat. (Temperatura): Defina a temperatura premindo UP ou DOWN.

• Distance (Distância): Se seleccionou os sapatos errados para o exercício, e se lhes atribuiu os dados

referentes à distância, pode introduzir aqui os sapatos correctos e a distância registada. Seleccione

os sapatos que usou durante o exercício e depois a distância. A distância é actualizada para os

sapatos seleccionados e nos diários da distância total e semanal. Também pode introduzir a

distância aqui se tiver efectuado exercício sem o sensor de pé*. Seleccione Other (Outro) para

registar a distância que não quer atribuir aos sapatos 1 ou 2.

b. Zonas de Desporto

Seleccione File > Exercise log > Zonas de desporto (Ficheiro > Diário de exercício > Zonas de desporto)

No visor informações básicas, prima DOWN para visualizar as informações das Zonas de desporto.

Prima primeiro OK e depois UP ou DOWN para ver o tempo passado em cada zona de desporto. Neste

caso, a variação das sessões é apresentada em formato gráfico.

Prima STOP para voltar a visualizar as informações das Zonas de desporto.

c. Fases

Seleccione File > Exercise log > Phases (Ficheiro > Diário de exercício > Fases)

O menu Phases (Fases) só é exibido se o exercício for criado com o software e incluir fases.

Na visualização de informações Sport zones (Zonas de desporto) prima DOWN para visualizar

informações sobre Phases (Fases). Pode visualizar cada fase separadamente.

Percorra os dados de uma determinada fase premindo OK. Compare as fases premindo UP ou DOWN.

Hora

Nome da fase

Tempo parcial

Duração da fase actual

Frequência cardíaca em batimentos por minuto (bpm) alternando com

uma percentagem da frequência cardíaca máxima (%) ou como uma

percentagem da frequência cardíaca de reserva.

Frequência cardíaca máxima

Frequência cardíaca média
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FC Aumentada / Recuperação FC / Diferença FC.

A diferença entre a frequência cardíaca no início e no fim da fase.

Frequência cardíaca actual em batimentos por minuto (bpm) alternando

com uma percentagem da sua frequência cardíaca máxima (%) ou como

uma percentagem da frequência cardíaca de reserva.

Increased HR: (FC Aumentada): Se a frequência cardíaca foi menor no

início do que no final da fase, o computador de corrida exibe a diferença

na frequência cardíaca (frequência cardíaca no final menos frequência

cardíaca no início). Durante a fase de trabalho o computador de corrida

mostra o valor do aumentado da frequência cardíaca.

Recovery HR: (FC de Recuperação): Se a frequência cardíaca foi maior no

início do que no final da fase o computador de corrida exibe a diferença

entre as frequências cardíacas (frequência cardíaca no início menos a

frequência cardíaca no final). Durante a fase de recuperação o

computador de corrida exibe o valor da frequência cardíaca de

recoperação.

HR differ: (Diferença FC): Se a frequência cardíaca foi a mesma no início

e no final da fase, o computador de corrida msotrará um valor 0 para a

diferença entre frequências cardíacas.

Velocidade/ritmo*

Velocidade/ritmo máximo

Velocidade/ritmo médio

Distância*

Distância parcial

Distância da fase actual

Cadência*

Cadência máxima

Cadência média da fase actual

Extensão da passada*

Comprimento médio da passada da fase actual

Prima STOP para voltar à vista da informação de Phases (Fases).

d. Voltas

Seleccione File > Exercise log > Laps (Ficheiro > Diário de exercício > Voltas)

Na visualização de informações de Fases veja informações das Voltas premindo DOWN. A informação

referente às voltas só é exibida se existir mais de uma volta em memória.

Número de voltas gravadas

Duração média da volta

Número da melhor volta (mais rápida) alternando com a respectiva

duração

A última volta nunca aparece como melhor volta, mesmo se tiver sido a volta mais rápida. Se estiver num
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evento desportivo e quiser incluir a último volta, prima OK na linha de chegada, em vez de STOP. Deste
modo, a última volta real é incluída nos cálculos para a melhor volta. Depois de passar a linha de chegada
pode parar a gravação.

Percorra os dados de uma determinada volta premindo OK.

Compare as informações de várias voltas premindo UP ou DOWN.

Para uma fácil visualização das informações referentes às voltas transfira os ficheiros para o software.

Tempo

Tempo parcial

Duração da volta

Frequência cardíaca em batimentos por minuto (bpm) alternando com

uma percentagem da frequência cardíaca máxima (%) ou como uma

percentagem da frequência cardíaca de reserva.

Frequência cardíaca máxima

Frequência cardíaca média

Frequência cardíaca final da volta

Velocidade/Ritmo*

Velocidade/ritmo médio

Velocidade/ritmo final da volta

Prima LIGHT sem libertar para comutar entre a velocidade/ritmo.

Distância*

Distância parcial

Extensão da volta

Cadência*

Máximo

Cadência média do volta.

Extensão da passada*

Extensão média da passada da volta

Altitude

Subida

Altitude do volta

Prima STOP para voltar a visualizar a informação do menu Laps (Voltas).

*É necessário utilizar o sensor de passada s3 stride sensor W.I.N.D. vendido separadamente.

Resumo Semanal

Seleccione File > Weekly (Ficheiro > Semanal)

Polar RS800 Manual do Utilizador 23



No sumário Weekly (Semanal) poderá ver os dados acumulados durante 16 semanas de exercícios. A

barra do lado direito, intitulada This week (Esta semana), ilustra o resumo dos exercícios da semana

actual. As outras barras possuem a data do Domingo da semana em causa. Percorra as diferentes

semanas premindo UP ou DOWN e visualize a duração total do exercício na linha de baixo.

Seleccione a semana com OK para visualizar o consumo calórico total, a distância * e o tempo de

exercício da semana. Prima DOWN para visualizar as zonas de desporto da semana.

Para ver o tempo passado em cada zona de desporto, prima OK e percorra as zonas de desporto

premindo UP ou DOWN.

Totais

Seleccionar File > Totals (Ficheiro > Totais)

Totals (Totais) inclui a informação cumulativa gravada durante as sessões de treino, desde a última

reinicialização. Utilize o ficheiro de valores Totais como um contador da época ou mensal dos dados

dos exercícios. Os valores são actualizados automaticamente quando se pára a gravação do exercício.

Utilize UP ou DOWN para percorrer as seguintes informações:

• Distância percorrida com os sapatos 1 ou adidas*

• Distância percorrida com os sapatos 2*

• Distância total*

• Duração total

• Consumo calórico total

• Contagem total das sessões de exercício

• Total a subir

• Reinicializar totais

Para reinicializar os valores totais

Seleccione File > Totals > Reset totals (Ficheiro > Totais > Reinicializar totais)

Seleccione o valor que pretende reinicializar no menu e confirme com OK. Para confirmar a

reinicialização seleccione Yes (Sim). A informação eliminada não pode ser recuperada. Seleccione No

(Não) para voltar ao menu Reset (Reiniciar).

Eliminar Ficheiros

Seleccione File > Delete > Totals (Ficheiro > Eliminar > Totais)

Em Delete (Eliminar) poderá eliminar exercícios anteriores um a um, todos os exercícios ao mesmo

tempo ou valores totais.

Percorra as informações seguintes utilizando os botões UP ou DOWN:

• Exercise (Exercício): Selecciona apenas um exercício para eliminar.

• All exerc. (Todos exerc.): Elimina todos os exercícios da memória premindo apenas um botão.

• Totals (Totais): Elimina os valores totais, um a um, ou todos os totais ao mesmo tempo.
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Confirme seleccionando Yes (Sim).

*É necessário utilizar o sensor de passada s3 stride sensor W.I.N.D. vendido separadamente.

7 . DEFINIÇÕES

Definições das Características

Sensor de Passada*

O computador de corrida permite-lhe medir a velocidade/ritmo, distância e cadência com um sensor de

passada*. Altere as definições do sensor de passada* no menu S sensor (Sensor de Passada).

Ligar e desligar a função velocidade e distância

Seleccione Settings > Features > S Sensor > On/Off (Definições > Características > Sensor de Passada >

Ligar/Desligar)

Calibrar o sensor de passada

Seleccione Settings > Features > S Sensor > Calibrate (Definições > Características > Sensor de Passada >

Calibrar)

Para obter mais informações consulte Calibrar o Sensor de Passada.

Utilizar um novo sensor*

Seleccione Settings > Features > S Sensor > New sensor (Definições > Características > Sensor de Passada

> Novo sensor)

Se utilizar um sensor de passada* novo terá de o apresentar ao computador de corrida. É a chamada

aprendizagem. Para obter mais informações, consulte a secção Aprendizagem.

Reinicializar todos os sensores de passada*

Seleccione Settings > Features > S Sensor > Remove all (Definições > Características > Sensor de Passada

> Remover todos)

É possível reinicializar todos os sensores de passada na memória do computador de corrida.

Altitude

O computador de corrida determina e indica a altitude. Altere as definições do altímetro no menu

Altitude (Altitude). Pode calibrar o altímetro manual ou automaticamente.

Activar ou desactivar a função altitude

Seleccione Settings > Features > Altitude > On / Off (Definições > Características > Altitude > Ligar /

Desligar)

Calibrar a Altitude Manualmente

Seleccione Settings > Features > Altitude > Calibrate (Definições > Características > Altitude > Calibrar) >

defina a altitude do local onde se encontra

Se a altitude do local onde se encontra diferir significativamente da altitude exibida, é exibida a

mensagem Calibrate to xx? (Calibrar para xx?).

• Yes (Sim): É exibida a indicação Altitude calibrated to xx (Altitude calibrada para xx).

• No (Não): É exibida a indicação Altitude Calibration canceled (A calibração da altitude foi

cancelada). É aplicada a última altitude gravada na memória do computador de corrida.

Calibre a altitude para garantir a sua exactidão. Defina a altitude de referência sempre que estiver

disponível um ponto de referência fiável, como um cume ou um mapa topográfico, ou quando estiver
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ao nível do mar.

Calibrar a Altitude Automaticamente

Seleccione Settings > Features > Altitude > > AutoCalib > On / Off (Definições > Características > Altitude >

Calibração Automática > Ligar / Desligar)

Durante o exercício, quando a calibração automática está activada, é aplicado o último valor da

altitude armazenado na memória do computador de corrida. Esta característica é particularmente útil

se iniciar sempre a sessão no mesmo ambiente. Se a calibração automática falhar, é porque não se

encontra no ambiente habitual e necessita de calibrar a altitude manualmente.

A indicação Altitude calibrated to xx m/ft (Altitude calibrada para xx m/ft) indica que a calibração foi bem

sucedida. Se visualizar a indicação Altitude calibration failed (Falha da calibração da altitude), volte a

calibrar a altitude.

Frequência da Gravação

Seleccione Settings > Features > Rec.rate > 1 / 5 / 15 / 60 sec (Definições > Características > Frequência

da Gravação > 1 / 5 / 15 / 60 seg)

O computador de corrida pode gravar a sua frequência cardíaca, velocidade/ritmo* e a altitude a que

se encontra, em intervalos de 1, 5, 15 ou 60 segundos. Um intervalo maior permite-lhe gravar durante

mais tempo, enquanto um intervalo menor permite-lhe gravar mais dados cardíacos e de outro tipo.

Isso permite uma análise de dados precisa, utilizando o software.

Uma frequência de gravação menor esgota a memória do computador de corrida mais rapidamente. O

tempo de gravação disponível é exibido na linha de baixo, quando se define a frequência. A frequência

de gravação predefinida é de 5 segundos.

Quando faltarem menos de 30 minutos de tempo máximo de gravação, a frequência de gravação muda

automaticamente para tempos de gravação mais longos (1s > 5s > 15s > 60s). Isto maximiza o tempo

disponível para a gravação dos dados do exercício. Quando a sessão termina, a frequência da gravação

seleccionada permanece como valor predefinido.

A tabela apresentada a seguir indica os tempos máximos de gravação para cada uma das frequências

de gravação. Note que a frequência de gravação pode mudar quando restarem menos de 30 minutos

de tempo de gravação.

Dados da

Frequência

de Gravação

Velocidade/RitmoAltitude Frequência de

Gravação 1s

Frequência

de Gravação

5s

Frequência

de Gravação

15s

Frequência de

Gravação 60 s

Desligar
Desligar Desligar 31h 30min 158h** 474h** 1899h**

Desligar
Desligar Ligar 10h 30 min 52h 40min 158h** 633h**

Desligar
Ligar Desligar 6h 10min 31h 30min 79h 316h**

Desligar
Ligar Ligar 4h 30min 22h 30min 59h 20min 237h**

Ligar
Desligar Desligar 18h 50min 18h 50min 18h 50 min 18h 50min

Ligar
Desligar Ligar 8h 30min 15h 10min 17h 30min 18h 30min

Ligar
Ligar Desligar 5h 30min 12h 30min 15h 40min 18h

Ligar
Ligar Ligar 4h 11h 14h 50min 17h 40min

** Corresponde à soma de 2 ou mais exercícios; a duração máxima de um exercício é de 99 h 59 min

59 s. O tempo máximo de gravação poderá ser menor se gravar mais exercícios de curta duração.

Os tempos apresentados na tabela são estimativas. Para os dados da frequência de gravação, o tempo
máximo de gravação depende da frequência cardíaca e da variação da frequência cardíaca. Se gravar
voltas no exercício e/ou criar um exercício com fases utilizando o software, o tempo máximo de gravação
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diminui.

A gravação não pára automaticamente quando a memória fica cheia. Por isso, a duração do exercício

poderá ser superior à duração da gravação.

Função Dados da Frequência de Gravação

Seleccione Settings > Features > RR Data > On / Off (Definições > Características > Frequência de Gravação

de Dados > Ligar / Desligar)

A função dados da frequência de gravação mede e regista variações dos batimentos cardíacos com

uma resolução de um milissegundo. Isto permite a análise (precisão de 1ms) do grau de variação da

frequência cardíaca (VFC) através o software. A função Dados da Frequência de Gravação utiliza muita

memória do computador de corrida, por isso, ao definir a função, o tempo de gravação disponível é

exibido na linha de baixo do visor.

Sapatos

Seleccione os sapatos com que pretende fazer exercício

Seleccione Settings > Features > adidas / Shoes 2 / Other (Definições > Características > adidas / Sapatos 2

/ Outros)

Para seguir e comparar a utilização de diferentes sapatos, o computador de corrida pode armazenar a

distância de corrida* para sapatos diferentes.

Renomeie os sapatos

Seleccione Settings > Features > adidas / Shoes 2 / Rename (Definições > Características > adidas / Sapatos

2 / Renomear)

Escreva o nome premindo UP, DOWN e OK.

Seleccione o tipo do seu sensor*

Seleccione Settings > Features > adidas / Shoes 2 > Sensor type > Integrated / Shoelaces (Definições >

Características > adidas > Sapatos 2 > Tipo de sensor > Integrado / Atacadores

Integrado: o sensor encontra-se num compartimento existente na sola do sapato (é necessário utilizar

calçado especial). Atacadores: o sensor é aplicado nos atacadores.

Ocorrem pequenas diferenças na medição de distâncias, consoante o sensor de passada esteja

colocado nos atacadores ou na sola do sapato. Para obter resultados mais precisos recomenda-se que

calibre o sensor sempre que alterar a sua posição. Para obter mais informações consulte Calibrar o

Sensor de Passada.

Utilizar Outros Sapatos

Seleccione Settings > Features > Shoes > Other (Definições > Características > Sapatos > Outros)

As distâncias de corrida só são acumuladas nos ficheiros de distância Total e Semanal, não sendo

atribuídas a um sapato específico.

Ao iniciar a gravação de um exercício pode mudar facilmente os sapatos seleccionados. No modo da hora
prima OK e DOWN, sem libertar. O número exibido no canto inferior direito do visor indica os sapatos
seleccionados.

Visualização da Velocidade*

Seleccione Settings > Features > Speed view > km/h (mph) ou min/km (min/mi) (Definições > Características >

Visualização da velocidade > km/h (mph) ou min/km (min/mi))

Gravação Automatic Lap* (Volta Automática*)

Seleccionar a Gravação da Volta Automática

Seleccione Settings > Features > A.Lap > On > set the lap distance (Definições > Características > Volta

Automática > Ligar > definir a extensão da volta)
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O computador de corrida grava as voltas automaticamente. Seleccione Off para desactivar.

Visualização da Frequência Cardíaca

Definir a visualização da frequência cardíaca

Seleccione Settings > Features > HR view > HR / HR% (Definições > Características > Visualização da FC >

FC / %FC)

Sport Zones (Zonas de Desporto)

Definir as zonas de desporto no computador de corrida

Seleccionar Settings > Features > Sport zones > Sport zone low limit (Definições > Características > Zonas de

desporto > limite inferior da zona de desporto)

Defina o limite inferior da zona de desporto 1 premindo UP ou DOWN. Depois, prima OK. Defina os

limites inferiores de cada zona de desporto de forma idêntica. Ao definir o limite inferior, o limite

superior da zona anterior é definido automaticamente.

Prima LIGHT, sem libertar, para comutar entre as visualizações das zonas de desporto: HR%

(percentagem da frequência cardíaca), BPM (batimentos por minuto) ou HRR% (percentagem da reserva

de frequência cardíaca).

Utilizando o software pode alterar facilmente as definições. Para obter mais informações, consulte a ajuda
do software.

*É necessário utilizar o sensor de passada s3 stride sensor W.I.N.D. vendido separadamente.

Definições de Utilizador

Introduza as definições do utilizador correctamente no computador de corrida para obter uma resposta

correcta em relação ao seu desempenho.

Para definir as informações do utilizador no computador de corrida

Seleccione Settings > User (Definições > Utilizador).

• Weight (Peso): Para mudar as unidades prima LIGHT, sem libertar.

• Height (Altura): Para mudar as unidades prima LIGHT, sem libertar.

• Birthday (Data de nascimento): dd=dia, mm=mês, yy=ano

• Sex (Sexo): Masculino/Feminino

• Activity (Actividade): Máxima / Forte / Moderada / Ligeira)

• Heart Rate (Frequência cardíaca): FC
máx

, FC
sent

• VO2max: Consumo máximo de oxigénio

Nível de Actividade

O nível de actividade é uma avaliação do seu nível de actividade física a longo prazo. Seleccione a

opção que melhor descreve a quantidade e intensidade global da sua actividade física nos últimos três

meses.

• Top (Máxima): Faz exercício físico intenso pelo menos 5 vezes por semana, ou faz exercício para

melhorar o seu desempenho para fins de competição.

• High (Forte): Faz exercício físico intenso pelo menos 3 vezes por semana; e.g, corre 10-40 km /

6-25 milhas por semana ou dedica 2-4 horas por semana a uma actividade física equivalente.

• Moderate (Moderada): Pratica regularmente desportos recreativos; e.g., corre 5-10 km / 3-6 milhas

por semana ou dedica 1/2-2 horas por semana a actividade física equivalente, ou o seu trabalho

requer uma actividade física modesta.

• Low (Baixa): Não pratica desportos recreativos ou actividades físicas intensas regularmente; por

exemplo, faz passeios a pé apenas por prazer ou pratica exercício físico, o suficiente para provocar

respiração forçada ou transpiração apenas ocasionalmente.
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No computador de corrida estes valores são usados para calcular o seu consumo de energia.

Heart Rate (Frequência cardíaca): FC
máx

, FC
sent

A FC
máx

(Frequência cardíaca máxima): Por predefinição é utilizado o valor previsto da FC
max

, com

base na idade (220 - idade). Defina a FC
max

manualmente se esta tiver sido determinada através de

uma prova de esforço, ou se a determinou você mesmo na prática.

A FC
sent

(Valor da frequência cardíaca na posição de sentado): Por predefinição é utilizado o valor

previsto da FCsent, com base na idade. Defina o valor de FC
sent

se o tiver determinado de acordo com

as instruções. Para obter instruções, consulte Valor da Frequência Cardíaca na Posição de Sentado .

Consumo Máximo de Oxigénio: VO
2max

O VO
2max

é a capacidade máxima do organismo para consumir oxigénio durante o esforço máximo. A

forma mais exacta de determinar o seu VO
2max

é através de uma prova de esforço. Se souber o seu

VO2maxdeterminado através de provas clínicas, defina esse valor no computador de corrida. Caso

contrário, determine um valor idêntico, o OwnIndex, fazendo o Polar Fitness Test. Para obter mais

informações, consulte Polar Fitness Test.

Se alterar as definições do utilizador é exibida a indicação User settings updated (Definições do utilizador

actualizadas).

Através do software pode alterar as definições facilmente. Para obter mais informações, consulte a ajuda
do software.

Definições Gerais

Som

Para definir o nível do som

Seleccione Settings > General > Sound > Volume > On/Off (Definições > Gerais > Som > Volume >

Ligar/Desligar)

As definições do volume controlam os sons dos botões e das actividades durante o exercício. Isto não

afecta os alarmes do relógio ou da zona-alvo (TZ Alarm).

Activar ou desactivar o Alarme da Zona Alvo

Seleccione Settings > General > Sound > TZ Alarm > On/Off (Definições > Gerais > Som > Alarme ZA >

Ligar/Desligar)

O alarme da zona-alvo soa e os limites piscam quando estiver fora da zona-alvo. Mesmo que o volume

esteja desligado, a função TZ Alarm (Alarme da Zona-alvo) continua funcional desde que permaneça

activada.

Bloqueio

Definir o bloqueio de botões

Seleccione Settings > General > Keylock > Manual / Automatic (Definições > Geral > Bloqueio > Manual >

Automático)

O Bloqueio de botões impede que se prima acidentalmente um dos botões.

• Manual: Active o bloqueio manual. Para activar/desactivar o bloqueio prima LIGHT sem libertar

durante pelo menos um segundo.

• Automático: O bloqueio é activado no modo da hora se não premir nenhum botão durante um

minuto.

Unidades

Define as unidades preferidas no computador de corrida
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Seleccione Settings > General > Units > kg/cm/km or lb/ft/mi (Definições > Geral > Unidades > kg/cm/km ou

lb/ft/in)

Idioma

Seleccionar o idioma

Seleccione Settings > General > Language > English / Deutsch / Español / Français (Definições > Gerais >

Idioma > Inglês / Alemão / Espanhol / Francês)

Hibernação

Activar a função hibernação

Seleccione Settings > General > Sleep > Activate sleep mode? > Yes (Definições > Gerais > Hibernação >

Activar modo de hibernação?)(Sim)

Activar o modo de hibernação ajuda a poupar a pilha quando o computador de corrida não é usado

durante bastante tempo. Mesmo assim, o despertador continua a funcionar no modo de hibernação.

Despertar o computador de corrida

Prima qualquer botão > Turn display on? > Yes / No (Ligar o mostrador? > Sim Não)

• Yes (Sim): o computador de corrida é activado.

• No (Não): o computador de corrida volta ao modo de hibernação.

Através do software pode alterar as definições facilmente. Para obter mais informações, consulte a ajuda
do software.

Definições do Relógio

Lembrete

Defina um lembrete para o lembrar as diversas tarefas ou exercícios

Seleccione Settings > Watch > Reminders > Add new (Definições > Relógio > Lembretes > Adicionar novo)

• Date (Data): Introduza a data da tarefa, dd=dia, mm=mês, yy=ano.

• Reminder time (Hora do lembrete): Introduza a hora a que pretende realizar a tarefa.

• Alarm (Alarme): Programe o alarme para soar à hora ou 10 min / 30 min / 1 hora antes da tarefa.

• Sound (Som): Seleccione o som do alarme para Silencioso / Beep / Normal (Silent / Beep / Normal).

• Repeat (Repetição): Seleccione o lembrete para repetir Uma vez / De hora em hora / Diariamente /

Semanalmente / Mensalmente / Anualmente (Once / Hourly /Dayly /Weekly / Monthly / Yearly).

• Exercise (Exercício): Seleccione um exercício ao qual pretenda ligar o lembrete. Quando o alarme

soa o computador de corrida apresenta este exercício como predefinição. Seleccione NONE

(Nenhum) se não quiser ligar o lembrete a uma sessão de exercício.

• Rename (Renomear): Para alterar o nome do lembrete seleccione as letras premindo UP ou DOWN e

aceite com OK.

É possível programar sete lembretes no computador de corrida.

Ver os lembretes activos e modificá-los

Seleccione Settings > Watch > Reminders (Definições > Relógio > Lembretes)

Seleccione um lembrete para visualizar, editar, renomear ou eliminar.

Evento

Definir a contagem decrescente para um evento no computador de corrida

Seleccione Settings > Watch > Event (Definições > Relógio > Evento)
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Event day: (Dia do evento): dd=dia, mm=mês.

Rename: (Renomear): Para renomear o evento seleccione as letras premindo UP ou DOWN e aceite com

OK.

Modificar a contagem decrescente para um evento

Seleccione Settings > Watch > Event (Definições > Relógio > Evento)

É possivel visualizar a contagem decrescente ou definir uma nova data para um evento, renomear ou

eliminar um evento.

No modo da hora, oculte ou visualize novamente a contagem decrescente para um evento premindo

UP sem libertar.

Alarme

Defina um alarme no computador de corrida

Seleccione Settings > Watch > Alarm > Off / Once / Mon-Fri / Daily (Definições > Relógio > Alarme >

Desligado / Uma vez / Seg-Sex / Diariamente)

É possível definir o alarme para soar uma vez todos os dias de Segunda a Sexta-feira, ou diariamente.

O alarme soa em todos os modos excepto no modo exercício e toca durante um minuto, a menos que

prima STOP. O despertador também funciona no modo de hibernação. O alarme soa mesmo com o

som desactivado nas Definições gerais.

Para uma pausa temporária do alarme durante 10 minutos, prima UP, DOWN ou OK: É visualizada a

indicação Snooze (pausa temporária), sendo iniciada a contagem decrescente da pausa temporária.

Para abortar a fase da pausa temporária e o modo de alarme, prima STOP.

Não é possível activar o alarme se o símbolo de pilha fraca for exibido no visor.

Hora

Defina a hora 1 no computador de corrida

Seleccione Settings > Watch > Time 1 > 24h / 12h (Definições > Relógio > Hora 1 > 24 h / 12 h)

Defina a hora 2 no computador de corrida

Seleccione Settings > Watch > Time 2 (Definições > Relógio > Hora 2)

Defina a diferença horária entre a hora 1 e a hora 2, em horas.

Comutar entre fusos horários

Seleccione Settings > Watch > Time zone > Time 1 / Time 2 (Definições > Relógio > Fuso horário > Hora 1 >

Hora 2)

Seleccionar um fuso horário

No modo da hora altere o fuso horário premindo DOWN sem libertar. O número 2 do canto inferior

direito do Visor indica que está a ser usada a Hora 2.

Data

Definir a data no computador de corrida

Seleccione Settings > Watch > Date (Definições > Relógio > Data)

dd=dia, mm=mês, yy=ano

Através do software pode alterar as definições facilmente. Para obter mais informações, consulte a ajuda
do software.

Personalize o Visor do Computador de Corrida durante o Treino

No modo da hora seleccione OK > Settings > Display > Edit (Definições > Visor > Editar)
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Personalize o visor do computador de corrida para visualizar a informação pretendida, utilizando o

computador de corrida ou o software. Um exercício programado descarregado do software tem o seu

próprio visor, que não pode ser modificado.

Para obter mais informações sobre os símbolos do visor, consulte Informações no Visor.

Seleccione o visor que pretende alterar premindo UP ou DOWN, e prima OK. Defina a informação da

linha de cima, que deverá ficar intermitente, premindo UP ou DOWN e prima OK. A informação

exibida no visor depende das características activadas. Para obter mais informações, consulte

Definições das Características .

Repita o mesmo procedimento para alterar a linha do meio e de baixo. Cada visor tem o nome da

informação exibida na linha de baixo. Para voltar às definições predefinidas do visor prima LIGHT, sem

libertar, quando as linhas estiverem a piscar.

Active a opção Titles (Títulos) para visualizar os textos de ajuda enquanto altera os visores durante o

exercício: No modo da hora seleccione OK > Settings > Display > Titles (Definições > Visor > Títulos)

Botão de Atalho (Menu Rápido)

Algumas definições podem ser alteradas no modo da hora utilizando um botão de atalho.

Prima LIGHT > Quick menu (LUZ > Menu rápido) sem libertar

• Keylock (Bloqueio)

• Reminders (Lembretes)

• Alarm (Alarme)

• Time zone (Fuso horário)

• Sleep (Hibernação)

Para obter mais informações, consulte 7. Definições.

8 . PROGRAMA DE TREINO

Programa de Visualização

É possível criar e transferir um programa de treino personalizado para o computador de corrida,

utilizando o Polar ProTrainer 5. Este capítulo fornece instruções básicas sobre a navegação e gestão do

programa depois de o transferir para o computador de corrida. Para obter mais informações sobre a

criação de exercícios programados com o software, sobre a sua transferência para o computador de

corrida e a análise do desempenho após o treino, consulte a ajuda do Polar ProTrainer 5.

Depois de transferir o programa são criados dois menus especiais no seu computador de corrida, onde

pode visualizar o programa e verificar o seu plano diário. Percorra as semanas, dias e exercícios

premindo UP e DOWN. Seleccione a semana e o dia com OK.

Visualizar o seu programa semanal

Seleccione Program > Week view (Programa > Visualizar a semana)

A opção visualizar a semana oferece-lhe um panorama geral dos exercícios semanais. A barra branca

representa a duração do exercício planeado e a barra negra representa a duração do exercício

executado. A duração dos objectivos de exercício semanais é exibida por baixo das barras.

Prima LIGHT sem libertar para visualizar as seguintes informações sobre a semana:
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• Week info (Informação sobre a Semana): Nome e descrição da semana.

• Targets (Objectivos): Resumo dos objectivos da semana. Calorias, distância* e duração. Tempo

planeado para as zonas de desporto: prima OK e percorra as zonas de desporto premindo UP ou

DOWN.

• Results (Resultados): Resumo dos resultados da semana. Calorias, distância* e duração. Tempo nas

zonas de desporto: prima OK e percorra as zonas de desporto utilizando os botões UP ou DOWN.

• Reminder (Lembrete): Defina o alarme (na hora, 10 min, 30 min ou 1 hora antes do exercício) e

defina o tipo de som (Silencioso, Beep, Normal).

• Program off (Programa desactivado): Remova o programa do computador de corrida.

Visualizar o seu programa diário

Seleccione Program > Week view > Day view (Programa > Visualizar a semana > Visualizar o dia)

Seleccionar Today > Exercise view (Hoje > Visualizar o exercício)

A visualização do dia fornece-lhe um panorama geral dos exercícios diários. A barra branca representa

a duração do exercício planeado e a barra negra representa a duração do exercício executado. Duração

dos objectivos de exercício diários é exibida por baixo das barras.

Prima LIGHT sem libertar para visualizar informações adicionais sobre o dia:

• Targets: (Objectivos): Resumo dos objectivos do dia. Calorias, distância* e duração. Tempo

programado para as zonas de desporto: prima OK percorra as zonas de desporto premindo UP ou

DOWN.

• Results: (Resultados): Resumo dos resultados do dia. Calorias, distância* e duração. Tempo nas

zonas de desporto: prima OK e percorra as zonas de desporto utilizando os botões UP ou DOWN.

Visualize o seu exercício diário

Seleccione Program > Week view > Day view > Exercise view (Programa > Visualizar a semana > Visualizar o

dia > Visualizar o exercício)

A visualização do exercício exibe as seguintes informações: nome do exercício, descrição e duração

pretendida.

Prima LUZ sem libertar para visualizar as seguintes informações:

• Targets: (Objectivos): Resumo dos objectivos para a sessão de treino. Calorias, distância* e duração.

Tempo programado para as zonas de desporto: prima OK e percorra as zonas de desporto utilizando

os botões UP ou DOWN.

• Phases: (Fases): Resumo das fases da sessão de treino.

• Sport profile: (Perfil de desporto): Visualizar o nome do perfil de desporto seleccionado. Para obter

mais informações, consulte a ajuda do software.

• Reminder: (Lembrete): Definir a hora do lembrete.

*É necessário o sensor de passada s3 stride sensor W.I.N.D. vendido separadamente.

Fazer Exercício Programado

Iniciar o treino

Se definiu um lembrete o seu computador de corrida vai lembrá-lo para treinar, de acordo com um

plano, na data programada. Verifique as informações sobre o exercício programado premindo OK

quando o lembrete tiver desaparecido.

Iniciar o Exercício Diário

Seleccione Today > Exercise view > Press OK > Press OK (Hoje > Visualizar o exercício > Prima OK >

Prima OK)

Seleccione Program > Week view > Day view > Exercise view > Press OK > Press OK (Programa > Visualizar

a semana > Visualizar o dia > Visualizar o exercício > Prima OK > Prima OK)

Para obter mais informações sobre a gravação do exercício, consulte Iniciar o Treino. O computador de

corrida orienta-o durante a sessão.
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Exercício com Fases

Segue-se um exemplo de um exercício com intervalos, dividido em quatro fases:

Warm up / P1 (Aquecimento / F1): Correr 10 minutos a uma frequência cardíaca de 55-65% da

frequência cardíaca máxima.

Interval / P2 (Intervalo / F2): Correr 3 km a um ritmo entre 3:30-4:00 min/km.

Recovery / P3 (Recuperação / F3): Após 3 km deixe a frequência cardíaca baixar para 120 bpm.

Repita as fases 2 e 3, 6 vezes cada.

Cool down / P4 (Arrefecimento / F4): Corra 10 minutos a um ritmo entre 5:00-6:00 min/km.

Visualizações durante o exercício

Durante o exercício são exibidos os seguintes tipos de visores:

Todas as fases começam por um visor indicando:

Nome da fase

Tipo de Zona

Limites da Zona

Número de repetições de fase em falta

Durante o exercício o visor da fase exibe:

Temporizador de contagem decrescente/distância*, temporizador de

contagem crescente, número da fase actual

A zona-alvo em formato gráfico (actualizada de 10 em 10 segundos,

mostrando os últimos 8 minutos)

Frequência cardíaca

Número de repetições da fase em falta

Qualquer fase termina com um visor de fim de fase, indicando:

Duração ou distância da fase*

Diferença da frequência cardíaca (aumento ou diminuição da frequência

cardíaca durante a fase) ou velocidade/ritmo médio

Frequência cardíaca média

Número da fase que terminou

Depois de executar o exercício programado o visor indica que o exercício

foi concluído.

O computador de corrida entra em modo de exercício Livre e pode

continuar a fazer exercícios, sem definições. O exercício é gravado e a

informação registada no Ficheiro até interromper o exercício.

Para obter mais informações sobre a planificação das sessões com o software e a sua transferência

para o computador de corrida, consulte a ajuda do software.

Funções Durante o Exercício

Tal como acontece em qualquer outro tipo de exercício, pode mudar as mesmas definições num

exercício programado. Para obter mais informações sobre as várias funções durante o exercício,

consulte Funções dos Botões durante o Exercício.

O exercício programado utiliza as definições do perfil de desporto seleccionadas no software. Se alterar

as definições do computador de corrida durante o exercício (e.g. o factor de calibração), as alterações
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só são aplicadas ao exercício actual. Da próxima vez que iniciar o mesmo exercício o computador de

corrida utiliza as definições do perfil de desporto definidas no software.

Menu da volta

Para visualizar o menu da volta durante o exercício programado, prima OK sem libertar. Percorra as

opções utilizando os botões UP ou DOWN e seleccione com OK. O conteúdo do menu da volta

depende do exercício.

• End phase (Terminar a fase): Terminar a fase actual e passar à fase seguinte do exercício.

• Jump to (Saltar para): Passar a qualquer outra fase do exercício.

• Lock zone (Bloquear zona) ou Unlock zone (Desbloquear zona): Bloqueie a frequência cardíaca ou a

velocidade/ritmo* numa zona de desporto específica, se estiver a fazer exercício sem zonas-alvo

predefinidas.

Visualizar Resultados do Exercício

Seleccione File > Exercise log (Ficheiro > Diário de exercício)

Depois de completar um exercício programado os dados do treino serão guardados em File (Ficheiro).

Para obter mais informações, consulte Analisar os Resultados do Exercício.

*É necessário utilizar o sensor de passada s3 stride sensor W.I.N.D. vendido separadamente.

9 . TESTES

Polar Fitness Test
TM

(Teste de Fitness Polar)

O Polar Fitness Test
TM

é uma maneira fácil, segura e rápida de medir a sua forma física aeróbica

(cardiovascular) em repouso. O resultado, o Polar OwnIndex, é idêntico ao seu consumo máximo de

oxigénio (VO
2max

), sendo normalmente usado para avaliar a forma física aeróbica. O nível de actividade

física a longo prazo, a frequência cardíaca, a variação da frequência cardíaca em repouso, o sexo, a

idade, a altura e o peso corporal, influenciam o OwnIndex. O Polar Fitness Test foi desenvolvido para

adultos saudáveis.

A forma física aeróbica está relacionada com o bom funcionamento do sistema cardiovascular, que se

reflecte no transporte de oxigénio para as diferentes partes do corpo. Quanto melhor for a forma física

aeróbica, mais forte e eficiente é o coração. A forma física aeróbica tem muitos benefícios para a

saúde. Por exemplo, ajuda a diminuir a hipertensão arterial e o risco de doenças cardiovasculares e de

trombose. Se pretende melhorar a forma física aeróbica, necessita de pelo menos seis semanas de

treino regular para poder observar uma alteração perceptível do seu OwnIndex. Se não estiver em

forma, a sua evolução será ainda mais perceptível. Quanto melhor for a sua forma física aeróbica,

menores serão as melhorias do seu OwnIndex.

A forma física aeróbica é melhorada por exercícios que utilizam grandes grupos de músculos. Estas

actividades incluem a corrida, os passeios a pé, o ciclismo, o remo, a natação, a patinagem e o esqui

de fundo.

Para monitorizar a sua evolução comece por medir o OwnIndex duas vezes durante as duas primeiras

semanas, para obter um valor base, depois, repita o teste aproximadamente uma vez por mês.

Com o Polar Fitness Test também poderá calcular a frequência cardíaca máxima prevista (FC
máx

-p). A

FC
máx

-p prevê a sua frequência cardíaca máxima com mais precisão do que a fórmula baseada na

idade (220 - idade). Para obter mais informações sobre a FC
máx

, consulte Definições do Utilizador.

Para garantir resultados fiáveis deverá ter em conta os seguintes requisitos básicos:

• O teste pode ser efectuado em qualquer lugar - em casa, no escritório ou no ginásio - desde que o

ambiente seja calmo. Não devem existir ruídos perturbadores (por exemplo, televisão, rádio ou

telefone) nem pessoas que estejam a falar consigo.

• Faça o teste sempre no mesmo ambiente e à mesma hora.
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• Evite fazer refeições pesadas ou fumar 2 a 3 horas antes do teste.

• Evite o esforço físico intenso, bebidas alcoólicas ou medicamentos estimulantes no dia do teste e

no dia anterior.

• Mantenha-se descontraído e calmo. Deite-se e descontraia-se durante 1 a 3 minutos antes de

iniciar o teste.

Antes do Teste

Colocar o transmissor

Para obter mais informações, consulte Iniciar o Treino.

Introduzir as Definições do Utilizador

Seleccione Settings > User (Definições > Utilizador).

Para efectuar o Polar Fitness Test, introduza os seus dados pessoais e o nível de actividade física de

longo prazo nas Definições do utilizador.

Activar a determinação da FCmax-p

Se quiser obter o valor da sua frequência cardíaca máxima prevista active a determinação da FC
máx

-p.

Seleccione Test > Fitness > HR max-p > On (Teste > Fitness > FC max-p > Activar)

Realizar o Teste

Seleccionar Test > Fitness > Start > Fitness Test Lie Down (Teste > Fitness > Início > Teste Fitness:

Deite-se)

O teste de fitness inicia-se dentro de cinco segundos. As setas indicam que o teste está em curso.

Mantenha-se descontraído e limite os movimentos corporais e a comunicação com outras pessoas.

Se não definiu o nível de actividade física a longo prazo nas Definições do Utilizador, será exibida a

mensagem Set your personal activity level (Defina o seu nível de actividade pessoal). Seleccione Top

(Máxima), High (Forte), Moderate (Moderada) ou Low (Ligeira) Para obter mais informações sobre os

níveis de actividade, consulte Definições de Utilizador.

Se o computador de corrida não captar a sua frequência cardíaca no início ou durante o teste, este não

é concluído com sucesso, sendo apresentada a mensagem: Test failed, check WearLink (Falha no teste,

verifique o WearLink). Verifique se os eléctrodos do transmissor estão húmidos e se a tira de tecido

está suficientemente justa ao corpo, e reinicie o teste.

Quando o teste estiver concluído, são emitidos dois sinais sonoros. O OwnIndex é exibido através de um

valor numérico e de uma indicação do nível. Para obter mais informações sobre as avaliações, consulte

Níveis de Fitness.

Para visualizar a Frequência cardíaca máxima prevista (Predicted maximum heart rate) prima DOWN.

Prima OK para sair.

Update to VO2 max? (Actualizar a VO2 max?)

• Seleccione Yes (Sim) para guardar o valor OwnIndex nas definições de utilizador e no menu Fitness

Test Trend (Tendência do Teste de Fitness).

• Seleccione No (Não) apenas se tiver determinado o seu VO
2max

por métodos clínicos e se este

diferir em mais de um nível de fitness do resultado do OwnIndex. O seu OwnIndex é guardado

apenas no menu Fitness Test Trend (Tendência do Teste de Fitness). Para mais informações, consulte

Tendência do teste de Fitness.

Update to HR max? (Actualizar a HR max?) (se a HRmax-p (FCmax-p) estiver activada)

• Seleccione Yes (Sim) para guardar o valor nas definições do utilizador.

• Seleccione No (Não) apenas se tiver determinado a sua FC
máx

por métodos clínicos.

Pode parar o teste em qualquer momento premindo STOP. A indicação Fitness Test canceled (Teste de

Fitness cancelado) é exibida durante alguns segundos.

Depois de guardar o OwnIndex e a FC
máx

-p, estes valores são utilizados para calcular o consumo calórico.
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Depois do Teste

Níveis de Fitness

O OwnIndex é mais significativo quando se comparam os seus valores individuais e as respectivas

alterações com o tempo. O OwnIndex também pode ser interpretado com base no sexo e na idade.

Localize o seu OwnIndex na tabela abaixo para determinar o seu actual nível de fitness aeróbica e

compare-o com os níveis de pessoas da mesma idade e do mesmo sexo.

Normalmente, os atletas de competição têm valores do OwnIndex acima de 70 (homens) e 60

(mulheres). Os atletas Olímpicos que praticam desportos de endurance podem atingir 95. O OwnIndex

é mais elevado em desportos que envolvem grandes grupos de músculos, como a corrida e o esqui de

fundo.

Homens

Idade / Anos Muito baixo Baixo Aceitável Moderado Bom Muito bom Excelente

20-24
< 32 32-37 38-43 44-50 51-56 57-62 > 62

25-29
< 31 31-35 36-42 43-48 49-53 54-59 > 59

30-34
< 29 29-34 35-40 41-45 46-51 52-56 > 56

35-39
< 28 28-32 33-38 39-43 44-48 49-54 > 54

40-44
< 26 26-31 32-35 36-41 42-46 47-51 > 51

45-49
< 25 25-29 30-34 35-39 40-43 44-48 > 48

50-54
< 24 24-27 28-32 33-36 37-41 42-46 > 46

55-59
< 22 22-26 27-30 31-34 35-39 40-43 > 43

60-65
< 21 21-24 25-28 29-32 33-36 37-40 > 40

Mulheres

Idade / Anos Muito baixo Baixo Aceitável Moderado Bom Muito bom Excelente

20-24
< 27 27-31 32-36 37-41 42-46 47-51 > 51

25-29
< 26 26-30 31-35 36-40 41-44 45-49 > 49

30-34
< 25 25-29 30-33 34-37 38-42 43-46 > 46

35-39
< 24 24-27 28-31 32-35 36-40 41-44 > 44

40-44
< 22 22-25 26-29 30-33 34-37 38-41 > 41

45-49
< 21 21-23 24-27 28-31 32-35 36-38 > 38

50-54
< 19 19-22 23-25 26-29 30-32 33-36 > 36

55-59
< 18 18-20 21-23 24-27 28-30 31-33 > 33

60-65
< 16 16-18 19-21 22-24 25-27 28-30 > 30

Estes valores baseiam-se numa revisão de 62 estudos em que o valor do VO
2max

foi medido

directamente em adultos saudáveis, nos EUA, no Canadá e em 7 países europeus. Fonte: Shvartz E,

Reibold RC: Aerobic fitness norms for males and females aged 6 to 75 years: a review. Aviat Space

Environ Med; 61:3-11, 1990.
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Tendência do teste de Fitness

Seleccione Test > Fitness > Trend (Teste > Fitness > Tendência

No menu Trend (Tendência) poderá visualizar a evolução do seu OwnIndex. São exibidos até 16 valores

do OwnIndex e as respectivas datas no visor. Quando o ficheiro da tendência do teste fica cheio o

resultado mais antigo é automaticamente eliminado.

São exibidos a data do teste mais recente, um gráfico dos resultados OwnIndex e o último valor

OwnIndex. Prima UP ou DOWN para visualizar outros valores.

Eliminar o Valor do OwnIndex

Seleccione Test > Fitness > Trend (Teste > Fitness > Tendência)

Seleccione o valor que deseja eliminar e prima LIGHT, sem libertar > Delete value? No/Yes (Eliminar

valor? Não/Sim). Confirme com OK.

Analisar os Resultados OwnIndex com o Software

Se transferir os resultados do teste para o software pode analisar os resultados de várias formas e

aceder a informações mais detalhadas sobre os seus progressos. O software também permite fazer

comparações gráficas com resultados anteriores.

Polar OwnOptimizer
TM

Geral

Treinar com sucesso exige uma sobrecarga temporária: maior duração dos exercícios, maior

intensidade ou maior volume total. Para evitar sobretreino grave, a sobrecarga tem de ser sempre

seguida de um período adequado de recuperação. Com um período de recuperação inadequado pode

ocorrer diminuição do desempenho, devido aos elevados volumes de treino, em vez de melhoria. O

Polar OwnOptimizer é uma forma simples e fiável de determinar se o seu programa de treino está a

melhorar optimamente o seu desempenho. O Polar OwnOptimizer é desenvolvido para ser utilizado por

adultos saudáveis.

O Polar OwnOptimizer é uma modificação de um teste ortostático tradicional de treino excessivo.

Trata-se de uma ferramenta perfeita, embutida no computador de corrida, para todos os que treinam

regularmente, pelo menos três vezes por semana, para melhorar a forma física ou para atingir

objectivos de competição. Este recurso baseia-se na frequência cardíaca e no grau de variação da

frequência cardíaca durante um teste ortostático (levantar-se a partir de uma posição de repouso

descontraído). O OwnOptimizer ajuda-o a optimizar a sua carga de treino durante um programa de

treino, de modo que possa experimentar uma melhoria do desempenho e, a longo prazo, evite o

subtreino ou sobretreino. O Polar OwnOptimizer baseia-se em determinações regulares, a longo prazo,

de cinco parâmetros da frequências cardíaca. Dois destes cinco valores são calculados em descanso,

um de pé, e dois enquanto se põe de pé. Sempre que realiza o teste a unidade de pulso guarda os

valores da frequência cardíaca e compara-os com os valores registados anteriormente.

Antes do Teste

Testes Basais

Ao utilizar o OwnOptimizer pela primeira vez deverá efectuar seis testes basais, durante um período de

duas semanas, para determinar o seu valor basal pessoal. Estas determinações dos valores basais

deverão ser efectuadas durante duas semanas típicas de treino básico e não durante duas semanas de

treino intenso. As determinações dos valores basais deverão incluir testes efectuados após um dia de

treino e depois de dias de recuperação.

Monitorizar os valores do OwnOptimizer

Depois de determinar os valores basais deverá continuar a fazer o teste 2-3 vezes por semana. Efectue

o teste semanalmente, na manhã seguinte a um dia de recuperação e a um dia de treino intenso (ou

após uma série de dias de treino intenso). Poderá efectuar um terceiro teste facultativo após um dia de

treino normal. O OwnOptimizer poderá não fornecer informações fiáveis se estiver a destreinar ou em
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períodos de treino muito irregular. Se deixar de se exercitar durante 14 dias ou mais, deve repetir os

testes para determinação dos valores basais.

Realizar o Teste

O teste deve ser sempre efectuado em condições normalizadas/semelhantes, no sentido e se obterem

os resultados mais fiáveis. Recomenda-se que faça o teste de manhã, antes do pequeno almoço.

Aplicam-se os requisitos básicos seguintes:

• Colocar o transmissor. Para obter mais informações, consulte Iniciar o Treino.

• Mantenha-se descontraído e calmo.

• Poderá estar sentado, numa posição descontraída ou deitado na cama. Sempre que efectuar o teste

a posição deverá ser sempre a mesma.

• O teste pode ser efectuado em qualquer local - em casa, no escritório ou num ginásio - desde que o

ambiente seja calmo. Não devem existir ruídos perturbadores (por exemplo, televisão, rádio ou

telefone) nem pessoas que estejam a falar consigo.

• Evite comer, tomar café e fumar nas 2-3 horas antes do teste.

Realizar o Teste

Seleccione Test > Optimizer > Start > Optimizer Lie Down (Teste > Optimizer > Início > Optimizer: Deite-se)

As setas indicam que o teste está em curso. Não se mexa durante a primeira parte do teste, que dura

3 minutos.

Passados 3 minutos a unidade de pulso emite um sinal sonoro e exibe a indicação Optimizer Stand up

(Optimizer: Levante-se). Levante-se e permaneça imóvel, de pé, durante 3 minutos.

Após 3 minutos a unidade de pulso emite novo sinal sonoro e o teste está terminado.

É exibida uma interpretação numérica e escrita do resultado. Prima DOWN para visualizar a sua

frequência cardíaca média (bpm) enquanto está deitado (HRrest) (FCrep), a frequência cardíaca mais

alta enquanto se põe de pé (HRpeak) (FCpico), e a frequência cardíaca média enquanto está de pé

(HRstand) (FCpé).

Pode parar o teste em qualquer momento premindo STOP. É exibida a indicação Optimizer Test

canceled (Teste Optimizer cancelado).

Se o computador não consegue receber o seu sinal de frequência cardíaca a mensagem Test failed.

Check WearLink (O teste falhou, verifique o WearLink) aparece. Nesse caso deve verificar se os

eléctrodos do transmissor estão húmidos e se a tira de tecido está suficientemente justa ao corpo.

Depois do Teste

Como Interpretaros Resultados

A unidade de pulso calcula cinco parâmetros com base na frequência cardíaca e na variabilidade da

frequência cardíaca. Os valores OwnOptimizer são calculados comparando os últimos resultados com

os anteriores. A unidade de pulso exibe uma descrição escrita do seu estado de treino. As descrições

estão pormenorizadas a seguir.

Good Recovery (Boa Recuperação) (1)

A sua frequência cardíaca é inferior à média. Isto indica que recuperou muito bem. Pode continuar a

treinar, mesmo com sessões de treino intensivo.

Normal State (Estado Normal) (2)

A sua frequência cardíaca está normal Continue a treinar; inclua sessões de treino ligeiro e intensivo,

bem como dias de recuperação.

Training Effect (Efeito de Treino) (3)

A sua frequência cardíaca é superior à média. Pode ter treinado intensivamente nos últimos dias. Tem

duas opções: 1) descansar ou fazer treinos ligeiros durante um ou dois dias, ou 2) continuar o treino

intensivo durante um ou dois dias e recuperar bem. Outras fontes de stress, como um princípio de

febre ou uma gripe, poderão resultar no mesmo tipo de resposta.

Steady State (Estado Estável) (4)
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Há muito tempo que a sua frequência cardíaca se apresenta normal. Um treino eficaz requer treino

intensivo e uma boa recuperação, o que deveria provocar variações na sua frequência cardíaca. O seu

resultado do OwnOptimizer indica que não faz treinos muito intensivos ou boas recuperações há algum

tempo. Volte a fazer o teste após um dia de descanso ou de treino ligeiro. Se a recuperação for eficaz,

o seu resultado deverá indicar Boa recuperação.

Stagnant State (Estado de Estagnação) (5)

A sua frequência cardíaca continua normal e está assim há muito tempo. O resultado indica que o seu

treino não tem sido suficientemente intenso para um desenvolvimento óptimo. Para melhorar

eficazmente a sua condição deve incluir sessões de treino mais intensas ou longas no seu programa.

Hard Training (Treino Duro) (6)

A sua frequência cardíaca foi várias vezes superior à média. Pode ter efectuado treino intenso de

propósito. O resultado indica sobrecarga, devendo tentar recuperar bem. Para monitorizar a sua

recuperação volte a repetir o teste após um ou dois dias de descanso ou de treino ligeiro.

Overreaching (Sobressolicitação) (7)

O resultado do OwnOptimizer indica que teve um período de treino muito intenso durante dias ou

semanas. A sua frequência cardíaca permaneceu continuamente elevada. Isto indica seriamente que

deverá fazer um período de recuperação completa. Quanto mais longo tiver sido o treino intenso mais

tempo é necessário para recuperar.. Volte a efectuar o teste depois de pelo menos dois dias de

recuperação.

Sympathetic Overtraining (Sobretreino de Influência Simpática) (8)

O resultado do OwnOptimizer indica que teve um período de treino muito intensivo durante vários dias

ou semanas e que a recuperação não foi suficiente. O resultado é um estado de sobretreino. Para

voltar a um estado de treino normal descanse durante um período de recuperação cuidadosamente

monitorizado. Após a recuperação, efectue o Teste OwnOptimizer 2–3 vezes por semana.

Parasympathetic Overtraining (Sobretreino de Influência Parassimpática) (9)

A sua frequência cardíaca permaneceu baixa o que, geralmente, é sinal de uma boa recuperação. No

entanto, existem outros parâmetros que indicam sobretreino de influência parassimpática. Pode ter

treinado com volumes elevados durante bastante tempo e a recuperação pode não ter sido suficiente.

Verifique se existem outros sinais de excesso de treino, como decréscimo de desempenho, acréscimo

de fadiga, alterações do humor, dificuldade em dormir, dores musculares permanentes e/ou uma

sensação de esgotamento ou cansaço. Também poderá ter estado sujeito a outros tipos de stress.

Geralmente, o sobretreino de influência parassimpática resulta de um longo historial de volumes de

treino pesados. Para recuperar de um sobretreino de influência parassimpática precisa de recuperar

completamente o seu equilíbrio corporal. A recuperação pode demorar várias semanas. Não deve

exercitar-se mas sim repousar totalmente, durante a maior parte do período de recuperação. Pode

ocupar alguns dias, com treino aeróbico ligeiro em sessões curtas e, apenas ocasionalmente, incluir

sessões curtas de alta intensidade.

Também pode considerar algo diferente do seu desporto principal. Nesse caso deve ser algo com que

esteja familiarizado e se sinta confortável. Monitorize a recuperação fazendo o Teste OwnOptimizer

2–3 vezes por semana. Quando sentir que recuperou o seu equilíbrio corporal e os resultados

indicarem Estado Normal ou Boa recuperação, de preferência mais de uma vez, pode pensar em

retomar o treino. Quando recomeçar o treino inicie um novo período de testes, com novas

determinações do valor basal.

Antes de mudar radicalmente o seu programa de treino avalie os resultados do OwnOptimizer juntamente
com as suas sensações subjectivas e quaisquer sintomas que sinta. Repita o teste OwnOptimizer se não
tiver a certeza de que as condições estão normalizadas. Um resultado individual do teste pode ser
afectado por vários factores externos, como o stress mental, doença latente, alterações ambientais
(temperatura, altitude) e outros. Deve actualizar as determinações do valor basal pelo menos uma vez por
ano, quando iniciar uma nova época de treinos.

Tendência OwnOptimizer

Seleccione Test > Optimizer > Trend (Teste > Optimizer > Tendência)
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Observe a evolução do valor do seu OwnOptimizer no menu Tendência. Esta tendência considera 16

dos seus últimos valores OwnOptimizer e as datas em que os resultados foram registados. Quando o

ficheiro de tendência ficar cheio, o último resultado OwnIndex substitui automaticamente o mais

antigo.

São exibidos a data do teste mais recente, um gráfico da tendência dos resultados e o último valor.

Prima OK para visualizar a descrição escrita do resultado. Prima UP ou DOWN para visualizar outros

valores.

Eliminar o Valor do OwnOptimizer

Seleccione Test > Optimizer > Trend (Teste > Optimizer > Tendência)

Seleccione o valor e prima LIGHT, sem libertar. É exibida a pergunta: Delete value? (Eliminar o valor?) É

exibida a indicação: No/Yes (Não/Sim). Confirme com OK.

Reset the Trend File (Reinicializar o Ficheiro Tendência)

Seleccione Test > Optimizer > Reset (Teste > Optimizer > Reinicializar)

É possível reinicializar o período de teste do OwnOptimizer. Todos os resultados do teste serão

eliminados da memória. Ao fazer o teste após um período de teste de 365 dias ou pela primeira vez

em 30 dias, é apresentada a pergunta Reset test period? (Reinicializar o período de teste?).

Analisar os Resultados com o Software

Se transferir os resultados do teste para o software pode analisar os resultados de várias formas e

aceder a informações mais detalhadas sobre os seus progressos. O software também permite fazer

comparações gráficas com resultados anteriores.

10 . UTIL IZAR UM ACESSÓRIO NOVO

Aprendizagem

O seu computador de corrida foi “ensinado” a trabalhar com o transmissor Polar WearLink W.I.N.D. e

com o sensor de passada s3 para medir a frequência cardíaca, a velocidade/ritmo e a distância. Por

outras palavras, o seu computador de corrida só recebe sinais do seu transmissor e sensor de passada,

permitindo-lhe exercitar-se em grupo, sem interferências.

Se adquirir um novo transmissor ou sensor de passada, é necessário apresentá-los ao computador de

corrida. É a chamada aprendizagem, que demora apenas alguns segundos.

Antes de participar numa competição não se esqueça de executar o processo de aprendizagem em casa.
Este procedimento evita interferências devidas à transmissão de dados a longa distância.

Ensinar um Novo Transmissor

No modo de tempo prima OK > New WearLink found, Teach new WearLink? (Novo WearLink encontrado,

Ensinar novo WearLink?)

Coloque o transmissor e assegure-se de que não está perto (20 m/66 ft) de outros transmissores Polar

WearLink W.I.N.D. No modo da hora, prima OK. O computador de corrida começa a procurar o sinal do

transmissor.

Uma vez identificado o novo transmissor, é apresentada a mensagem: New WearLink found, Teach new

WearLink? (Foi encontrado um novo WearLink, Ensinar novo WearLink?).

• Seleccione Yes (Sim) para confirmar a aprendizagem. É exibida a indicação Completed! (Concluída!).

Inicie a gravação do exercício premindo OK.

• Seleccione No (Não) para cancelar a aprendizagem.

Ensinar um Novo Sensor de Passada

Seleccione Settings > Features > S Sensor > New sensor (Definições > Características > Sensor de Passada

> Novo sensor)

Assegure-se de que não está perto (20 metros/66 ft) de outros sensores de passada. O sensor deve
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estar num raio de 1,5 metros/5 ft do computador de corrida.

É exibida a mensagem: Teach new sensor? (Ensinar um novo sensor?).

• Seleccione Yes (Sim) para confirmar a aprendizagem. É exibida a indicação Completed! (Concluída!).

• Seleccione No (Não) para cancelar a aprendizagem. O computador de corrida não consegue medir a

velocidade/ritmo ou distância.

É possível registar até quatro sensores na memória do seu computador de corrida. Se este número for

excedido, o sensor menos usado é substituído.

11 . INFORMAÇÕES GERAIS

Zonas de Desporto Polar

As zonas de desporto Polar conferem um novo nível de eficácia ao treino baseado na frequência

cardíaca. O treino está dividido em cinco zonas de desporto, baseadas em percentagens da frequência

cardíaca máxima. Através das zonas de desporto é fácil seleccionar e monitorizar as intensidades do

treino.

Zona alvo
Intensidade %

de FC
máx

, bpm Exemplos de

Duração

Benefícios para o treino

MÁXIMO
90–100%

171–190 bpm

menos de 5

minutos

Benefícios: Esforço máximo, ou perto

do máximo, para a respiração e

músculos.

Sensação: Muito extenuante para a

respiração e músculos.

Recomendado para: Corredores muito

experientes e em forma. Só por

períodos curtos, geralmente na

preparação final para provas de corrida

curtas.

DIFÍCIL
80–90%

152–172 bpm

2–10

minutos

Benefícios: Capacidade acrescida para

resistência a alta velocidade.

Sensação: Provoca fadiga muscular e

respiração ofegante.

Recomendado para: Corredores

experientes para treinos durante todo

ano, de duração variável. Torna-se mais

importante durante a época

pré-competição.

MODERADO
70–80%

133–152 bpm

10–40

minutos

Benefícios: Intensifica o ritmo geral de

treino, torna mais fáceis os esforços de

intensidade Moderada e melhora a

eficiência.

Sensação: Respiração rápida, regular e

controlada.

Recomendado para: Corredores em

melhoria com vista a provas ou que

querem ganhos de desempenho,

sobretudo no treino para a meia

maratona e maratona.
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Zona alvo
Intensidade %

de FC
máx

, bpm Exemplos de

Duração

Benefícios para o treino

LIGEIRO
60–70%

114-133 bpm

40–80

minutos

Benefícios: Melhora a forma física geral

básica, melhora a recuperação e reforça

o metabolismo.

Sensação: Confortável e fácil, baixa

carga muscular e cardiovascular.

Recomendado para: Todos, para

sessões de treino prolongadas durante

períodos de treino básico e para

exercícios de recuperação durante a

época de competição.

MUITO LIGEIRO
50–60%

104–114 bpm

20–40

minutos

Benefícios: Ajuda no aquecimento e

arrefecimento e auxilia a recuperação.

Sensação: Muito simples, pouco

esforço.

Recomendado para: Para exercícios de

recuperação e arrefecimento durante

toda a época de treinos.

FC
máx

= Frequência cardíaca máxima (220-idade). Exemplo: 30 anos, 220-30=190bpm.

A corrida na zona de desporto 1 ocorre a uma intensidade muito baixa. O principal princípio do treino

reside no facto do seu nível de desempenho melhorar durante a recuperação pós-treino, e não apenas

durante o treino. Pode acelerar o processo de recuperação com treinos de intensidade muito ligeira.

A zona de desporto 2 destina-se a treino de resistência, uma parte essencial de qualquer programa de

treino. As sessões de corrida nesta zona são ligeiras e aeróbicas. Nesta zona ligeira, o treino de longa

duração origina um consumo eficaz de energia. A evolução requer persistência.

O poder aeróbico é melhorado na zona de desporto 3. A intensidade de treino é superior à das zonas

de desporto 1 e 2, mas continua a ser sobretudo aeróbica. Por exemplo, o treino na zona de desporto 3

consiste em intervalos seguidos de recuperação. A corrida nesta zona é especialmente importante para

melhorar a eficácia da circulação sanguínea no coração e nos músculos esqueléticos.

Se o seu objectivo é competir com o máximo potencial, terá de treinar nas zonas de desporto 4 e 5.

Nestas zonas, efectua corrida anaeróbica em intervalos de até 10 minutos. Quanto mais curto for o

intervalo, maior é a intensidade. É muito importante recuperar o suficiente entre intervalos. O padrão

de treino nas zonas 4 e 5 está concebido para produzir um desempenho máximo.

As zonas de desporto Polar podem ser personalizadas usando um valor da FC
máx

determinado em

laboratório adequado, ou usando um teste prático para medir esse valor, que você mesmo pode

efectuar. Quando correr numa zona de desporto, tente utilizar toda a zona. A zona média é um bom

objectivo mas não é necessário manter sempre a sua frequência cardíaca nesse valor exacto. A

frequência cardíaca ajusta-se, gradualmente, à intensidade de treino. Por exemplo, quando passar da

zona de desporto 1 para a 3, o sistema circulatório e a frequência cardíaca adaptam-se em 3-5

minutos.

A frequência cardíaca responde à intensidade do treino de acordo com factores como o nível de forma

física e de recuperação, e com factores ambientais. É importante estar atento a sensações subjectivas

de fadiga e ajustar o programa de treino em conformidade.

Uma forma simples de utilizar as zonas de desporto é criar as suas zonas-alvo de frequência cardíaca.

Para obter mais informações, consulte Planifique o seu Treino.

Após o exercício a duração deste é apresentada em zonas de desporto. Aceda ao visor Semanal para

visualizar as zonas de desporto em que se exercitou e o tempo que permaneceu em cada uma.

O Polar ProTrainer 5 apresenta até 10 zonas de desporto, para melhor servir as suas necessidades de

treino e a frequência cardíaca de reserva.
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Treinar na OwnZone

O computador de corrida determina automaticamente uma zona de intensidade de exercício, individual

e segura: a sua OwnZone. A Polar OwnZone, de características ímpares, define a sua zona de exercício

pessoal para o exercício aeróbico. A função orienta-o no aquecimento e tem em consideração a sua

condição física e psíquica actual. Para a maior parte dos adultos a OwnZone corresponde a 65-85% da

frequência cardíaca máxima.

A OwnZone pode ser determinada em 1 a 5 minutos, durante um período de aquecimento, a andar,

correr ou a praticar qualquer outro desporto. A ideia é começar a praticar exercício devagar, com pouca

intensidade, e aumentar gradualmente a intensidade e a frequência cardíaca. A OwnZone foi

desenvolvida para ser utilizada por pessoas saudáveis. Alguns problemas de saúde podem originar

falhas na determinação da OwnZone baseada na variabilidade da frequência cardíaca. Entre eles

incluem-se a hipertensão arterial, arritmias cardíacas e algumas medicações.

Estar atento e interpretar os sinais que o seu corpo envia durante o esforço físico é um passo para

alcançar a forma física. Em virtude das rotinas de aquecimento diferirem com o tipo de exercício e

uma vez que o estado físico e psíquico também pode variar de dia para dia (devido ao stress ou

doença), a utilização da função OwnZone em todas as sessões garante a utilização da zona-alvo da

frequência cardíaca mais eficaz para esse exercício e para esse dia.

Frequência Cardíaca Máxima

A Frequência cardíaca máxima (FC
máx

) é o número mais elevado de batimentos cardíacos por minuto

(bpm) durante o máximo esforço físico. Trata-se de um valor individual que depende da idade, de

factores hereditários e do nível de forma física. Também pode variar com o tipo de desporto praticado.

A FC
máx

é utilizada para exprimir a intensidade do exercício.

Determinar a Frequência Cardíaca Máxima

A sua FC
máx

pode ser determinada de várias maneiras.

• A forma mais rigorosa é determinar a FC
máx

através de processos clínicos, geralmente mediante

prova de esforço realizada em tapete rolante ou bicicleta, sob supervisão de um cardiologista ou

técnico de fisiologia.

• Também pode determinar a sua FC
máx

através de um teste prático, realizado com um dos seus

parceiros de treino.

• Pode obter um valor de FC
máx

-p que prediz a sua FC
máx

efectuando o Polar Fitness Test.

• A FC
máx

também pode ser determinada através de uma fórmula comum: 220 - idade, embora

existam estudos que demonstraram que o método não é muito preciso, especialmente no idoso ou

em pessoas que estejam em boa forma há muitos anos.

Se tem treinado intensamente nas últimas semanas e sabe que pode atingir a frequência cardíaca

máxima em segurança pode, você mesmo, efectuar o teste para determinar a FC
máx

. Recomenda-se

que faça o teste na presença de um parceiro de treino. Se não tiver a certeza consulte o seu médico

antes de efectuar o teste.

Apresentamos a seguir um exemplo de um teste simples.

Passo 1: Faça um aquecimento de até 15 minutos numa superfície plana, preparando-se para o seu

ritmo habitual de treino.

Passo 2: Escolha um terreno inclinado ou escadaria que demore mais de 2 minutos a subir. Suba o

terreno inclinado/escadaria uma vez, a correr, adoptando o ritmo mais intenso que conseguir aguentar

durante 20 minutos. Regresse ao ponto de partida no terreno inclinado/escadaria.

Passo 3: Volte a subir o terreno inclinado/escadaria, a correr, adoptando um ritmo que consiga

aguentar durante 3 quilómetros. Anote a sua frequência cardíaca mais alta. O seu máximo são cerca

de 10 batimentos mais do que o valor anotado.

Passo 4: Desça o terreno inclinado a correr, deixando a frequência cardíaca baixar 30-40 batimentos

por minuto.

Passo 5: Volte a subir o terreno inclinado/escadaria a correr, a um ritmo que só consiga aguentar

durante 1 minuto. Tente subir metade do terreno inclinado/escadaria a correr. Anote a sua frequência

cardíaca mais alta. Este valor está perto da sua frequência cardíaca máxima. Utilize este valor como a

sua frequência cardíaca máxima, para definir as zonas de treino.
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Passo 6:: Faça um bom relaxamento,10 minutos no mínimo.

Valor da Frequência Cardíaca na Posição de Sentado

A FC
sent

é a frequência cardíaca média quando está completamente imóvel (i.e. quando está sentado).

Para determinar facilmente a FC
sent

, coloque o transmissor, sente-se, e não execute nenhuma

actividade física. Para efectuar uma determinação mais rigorosa, repita o procedimento várias vezes e

calcule a média.

Frequência Cardíaca de Reserva

A frequência cardíaca de reserva (FCR) é a diferença entre a frequência cardíaca máxima (FC
máx

), e a

frequência cardíaca em repouso (FC
rep

)*. A FCR é usada para calcular frequências cardíacas do

exercício. Trata-se do intervalo em que varia a frequência cardíaca, dependendo do nível de esforço

efectuado. A FCR é igual ao consumo de oxigénio de reserva (VO
2
R).

A frequência cardíaca do exercício pode ser determinada através da fórmula de Karvonen**. Adicione a

percentagem da frequência cardíaca de reserva obtida à frequência cardíaca em repouso.

FC Exercício = % da intensidade alvo (FC
máx

– FC
rep

) + FC
rep

Exemplo:

Intensidade alvo 70 % FCR para uma pessoa com FC
máx

de 201 bpm e FC
rep

de 50 bpm

FC Exercício = 70% (201-50) + 50

FC Exercício =156 bpm

Para uma frequência cardíaca de exercício rigorosa, necessita de valores exactos da FC
máx

e da FC
rep

,

determinada através de métodos clínicos. Se utilizar valores calculados para a FC
máx

, os valores da

frequência cardíaca de exercício serão sempre estimativas.

*Nos computadores de corrida Polar, RS400 e RS800, o valor da frequência cardíaca em repouso é

medido na posição de sentado FC
sent

. Tal facto deve-se a razões práticas, em virtude da FC
sent

ser

usada em cálculos do dispêndio de energia, tendo em conta a precisão. A FC
sent

equipara-se à baixa

intensidade em relação à qual podem ser comparadas as várias intensidades dos exercícios.

**Karvonen M, Kentala K, Mustala O. The effects of training on heart rate: a longitudinal study. Ann

Med Exp Biol Fenn 1957; 35: 307-315.

Variabilidade da frequência cardíaca

A frequência cardíaca varia a cada batimento cardíaco. A variabilidade da frequência cardíaca (VFC) é

a variação dos intervalos batimento a batimento, também conhecidos por intervalos R-R.

A VFC indica as flutuações da frequência cardíaca à volta de uma frequência cardíaca média. Uma

frequência cardíaca média de 60 batimentos por minuto (bpm) não significa que o intervalo entre

batimentos sucessivos seja exactamente 1,0 seg, pois este pode variar entre 0,5 seg e 2,0 seg.
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A VFC é afectada pela forma física aeróbica. A VFC de um coração saudável é geralmente maior

durante o descanso. Os outros factores que afectam a VFC são a idade, as características genéticas, a

postura corporal, a hora do dia e o estado de saúde. Durante o exercício, a VFC diminui à medida que

a intensidade da frequência cardíaca e do exercício aumentam. A VFC também diminui durante

períodos de stress psicológico.

A VFC é regulada pelo sistema nervoso autónomo. As actividades parassimpáticas diminuem a

frequência cardíaca e aumentam a VFC, enquanto que as actividades simpáticas aumentam a

frequência cardíaca e diminuem a VFC.

A VFC é usada na Ownzone e no OwnIndex, bem como nas características do OwnOptimizer. Também

pode ser monitorizada individualmente com o computador de corrida. Se a sua VFC se altera a um

determinado ritmo de corrida e frequência cardíaca, isso pode indicar uma alteração na carga e stress

do seu treino.

Cadência de Corrida e Extensão da Passada

Cadência* é o número de vezes por minuto que o pé que tem o sensor de passada* toca no chão, por

minuto.

Extensão da passada* é a extensão média de um passo Geramente, a distância entre os pontos de

contacto do pé direito e esquerdo com o chão.

Velocidade de corrida = 2 * extensão da passada * cadência

Existem duas maneiras de correr mais depressa: mover as pernas a uma cadência maior ou dar

passadas mais longas.

Geralmente, os corredores de fundo de elite, correm a uma cadência elevada de 85-95. Nas subidas,

os valores típicos da cadência são menores. Nas descidas, são maiores. Os corredores ajustam a

extensão da passada ao passo de ganso: a extensão da passada aumenta com a velocidade.

Contudo, um dos erros mais comuns dos corredores novatos é dar passadas longas demais. O

comprimento de passada mais eficaz é o natural – aquele a que nos sentimos confortáveis. Durante

provas, pode correr mais rapidamente se fortalecer os músculos das pernas, o que lhe permite dar

passadas mais longas.

Também deve trabalhar para maximizar a eficiência da cadência. A cadência não apresenta uma

evolução fácil, mas se for adequadamente treinada pode mantê-la durante as provas e maximizar o seu

desempenho. Para desenvolver a cadência necessita de treinar a ligação nervo-músculo - com uma

frequência razoável. Uma sessão de treino da cadência por semana é um bom início. Inclua algum

trabalho de cadência no resto da sua semana. Nas corridas fáceis e extensas pode, de vez em quando,

incluir alguma cadência mais rápida.

Durante o treino para eventos mais longos (½ Maratona, Maratona ou mais), pode ser útil monitorizar a

cadência. Uma cadência baixa no ritmo de prova esperado pode causar problemas numa fase posterior

do evento, à medida que as suas pernas ficarem cansadas. Uma forma de contornar esta situação é

trabalhar no aumento da velocidade das pernas ao ritmo de prova esperado. É possível definir o

computador de corrida para exibir o ritmo e a cadência. Tente encurtar a passada e aumentar a

cadência, mantendo o mesmo ritmo (defina uma zona de ritmo estreita para emitir um sinal sonoro).

Pode traçar como objectivo aumentar a cadência de corrida acima de:

• 80/min (Maratonistas de 4 horas)

• 85/min (Maratonistas de 3h e 30min)

• 88/min (Maratonistas de 3 horas)

Estes valores são apenas sugestivos, os corredores mais altos têm, naturalmente, cadências

ligeiramente menores. Os corredores também devem estar atentos ao seu conforto pessoal.

Uma boa maneira de melhorar a extensão da passada é executar trabalho de força específico, como

subir colinas a correr, correr em areia macia ou subir escadas a correr. Um período de treino de seis

semanas, com trabalho de fortalecimento, deve originar melhorias perceptíveis da extensão da passada

e, se for combinado com trabalho para aumentar a velocidade das pernas (como passadas curtas ao

melhor ritmo de 5 km), também deve originar melhorias perceptíveis na velocidade geral.

*É necessário utilizar o sensor de passada s3 stride sensor W.I.N.D. vendido separadamente.
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Frequência de Gravação R-R

A frequência de gravação R-R regista os intervalos dos batimentos cardíacos, i.e., os intervalos entre

batimentos sucessivos. Esta informação também é apresentada nas amostras gravadas, como

frequência cardíaca instantânea, em batimentos por minuto.

Quando se gravam todos os intervalos também é possível registar extra-sístoles e alterações cardíacas.

Recomendamos o uso de gel de contacto (gel para ECG) para optimizar o contacto entre a sua pele e o

transmissor. As leituras interpretadas como incorrectas nos dados da frequência cardíaca, podem ser

ajustados e corrigidas com o software.

Índice de Corrida Polar

O Índice de Corrida fornece uma maneira fácil de monitorizar as alterações doe desempenho. O

desempenho (a rapidez/facilidade de corrida a um certo ritmo) é directamente influenciado pela forma

física aeróbica (VO2max) e pela economia de exercício (a eficiência do seu corpo ao correr), sendo o

Índice de Corrida uma medida dessa influência. Ao gravar o seu Índice de Corrida com o tempo,

poderá monitorizar a sua evolução. Melhoria significa que, a um determinado ritmo, a corrida exige

menos esforço, ou que o seu ritmo é mais rápido a um determinado nível de esforço. A característica

Índice de Corrida calcula essas melhorias. O Índice de Corrida também lhe fornece informações diárias

sobre o seu nível de desempenho na corrida, que pode variar de dia para dia.

Benefícios do Índice de Corrida:

• realça os efeitos positivos das boas sessões de treino e dos dias de descanso.

• monitoriza o desenvolvimento da forma física e do desempenho a vários níveis de frequência

cardíaca - e não apenas durante o desempenho máximo.

• pode determinar a sua velocidade de corrida ideal comparando índices de corrida de diferentes

tipos de treinos.

• dá ênfase à evolução, através de uma melhor técnica de corrida e nível de forma física.

O Índice de Corrida é calculado durante todos os exercícios em que a frequência cardíaca e o sinal do

sensor de passada* são gravados e quando se aplicam os seguintes requisitos:

• a velocidade deve ser digual ou superior a 6km/h / 3,75 mph e a duração deve ser, no mínimo, 12

minutos.

• a frequência cardíaca deve ser superior a 40% da FC
máx

.

Assegure-se de que o sensor de passada está calibrado. A determinação inicia-se quando começa a

gravar a sessão, que dura um máximo de 60 minutos. Durante a sessão poderá parar uma vez, nos

semáforos, por exemplo,sem afectar a determinação.

No final, o computador de corrida apresenta um valor do Índice de Corrida e guarda o resultado na

secção File. Compare o seu resultado com a tabela seguinte. Através do software pode monitorizar e

analisar a evolução do seu Índice de Corrida, em relação ao tempo e a várias velocidades de corrida.

Também pode comparar os valores de várias sessões de exercício e analisá-las a curto e a longo prazo.

Análise a curto prazo

Índice de Corrida Nível de Desempenho

> 30
Muito fraco

31-37
Fraco

38-44
Aceitável

45-51
Médio

52-58
Bom

59-65
Muito bom

> 65
Excelente
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Poderão ocorrer algumas variações diárias nos Índices de Corrida devido a circunstâncias da corrida,

e.g. superfície, inclinação do terreno, vento, temperatura.

Análise a longo prazo

Os Índices de Corrida formam uma tendência que permite prever o seu sucesso em determinadas

distâncias.

A tabela seguinte estima o tempo que um corredor demora a percorrer determinadas distâncias com

um desempenho máximo. Utilize a média do seu Índice de Corrida a longo prazo. A previsão funciona

melhor para os valores do Índice de Corrida registados a uma velocidade e circunstâncias de corrida

semelhantes ao desempenho pretendido.

Índice de

Corrida

Teste de

Cooper (h)

5 km (h:mm:ss) 10 km (h:mm:ss) 21,098 km

(h:mm:ss)

42,195 km

(h:mm:ss)

36
1900 0:37:30 1:16:00 2:45:00 5:45:00

38
2000 0:35:00 1:11:30 2:34:00 5:20:00

40
2100 0:32:30 1:06:30 2:24:00 5:00:00

42
2200 0:30:45 1:03:00 2:16:00 4:45:00

44
2300 0:29:00 0:59:30 2:09:00 4:30:00

46
2400 0:28:00 0:57:30 2:04:00 4:20:00

48
2500 0:26:45 0:55:00 1:59:00 4:10:00

50
2600 0:25:30 0:52:30 1:54:00 4:00:00

52
2700 0:24:15 0:50:00 1:49:00 0:50:3

54
2850 0:23:15 0:48:00 1:44:00 3:40:00

56
2950 0:22:15 0:46:00 1:40:00 3:32:00

58
3100 0:21:15 0:44:00 1:36:00 3:25:00

60
3200 0:20:30 0:42:30 1:33:00 3:18:00

62
3300 0:19:30 0:40:30 0:29:1 3:10:00

64
3400 0:19:00 0:39:30 1:26:00 3:05:00

66
3500 0:18:30 0:38:30 1:24:00 3:00:00

68
3650 0:17:45 0:37:00 1:21:00 0:55:2

70
3750 0:17:15 0:36:00 0:19:1 0:50:2

72
3900 0:16:30 0:34:30 1:16:00 2:45:00

74
4000 0:16:00 0:33:30 1:14:00 2:40:00

76
4100 0:15:30 0:32:30 1:12:00 0:35:2

78
4200 0:15:15 0:32:00 1:10:00 2:30:00

*É necessário utilizar o sensor de passada s3 stride sensor W.I.N.D. vendido separadamente.

Vale a pena lembrar que, para além de um bom Índice de Corrida, o desempenho máximo durante a
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corrida requer uma boa preparação, condições de corrida ideais, resistência à velocidade e coragem. A

quantidade e a qualidade do treino produzem um efeito e um talento natural.

Biblioteca de Artigos Polar

Para mais informações sobre a melhoria da sua corrida, visite a Biblioteca de Artigos Polar

[http://articles.polar.fi].

12 . INFORMAÇÕES SOBRE A ASSISTÊNCIA A CLIENTES

Cuidados e Manutenção

Cuidar do Produto

Tal como qualquer outro dispositivo electrónico, o computador de corrida Polar deve ser tratado com

cuidado. As sugestões apresentadas a seguir vão ajudá-lo a cumprir os requisitos de garantia e a tirar

partido deste produto, durante muitos anos.

Retire o transmissor da tira elástica depois de o utilizar. Limpe o conector com uma solução de água e

sabão suave. Seque-o com uma toalha. Nunca utilize álcool ou qualquer material abrasivo (como

palha-de-aço ou químicos de limpeza).

Enxagúe a tira elástica do transmissor após cada utilização. Se usar a tira elástica mais de três vezes

por semana lave-a à máquina, pelo menos de três em três semanas, a 40°C / 104°F. Utilize uma bolsa

de lavagem. Não deixe de molho e não use detergente com lixívia nem amaciador de tecidos. Não lave

a seco nem branqueie a tira elástica.

Lave a tira elástica antes de a guardar por períodos prolongados e sempre que a utilizar em piscinas

com um elevado teor de cloro. Não seque a tira com centrifugação nem a passe a ferro. Nunca coloque

o conector numa máquina de lavar ou de secar! Seque e guarde a tira elástica e o conector

separadamente.

Guarde o computador de corrida, o transmissor e o sensor de passada num local fresco e seco. Não os

guarde num ambiente húmido, dentro de materiais que impeçam a respiração (como um saco de

plástico ou um saco de desporto), nem juntamente com materiais condutores (como uma toalha

molhada). Não mergulhe o sensor de passada na água. Não exponha à luz solar directa durante

períodos de tempo prolongados.

As temperaturas de funcionamento são -10 °C a +50 °C / +14 °F a +122 °F.

Assistência

Durante os dois anos do período de garantia, recomendamos que a assistência seja prestada apenas

num Centro de Assistência Polar autorizado. A garantia não cobre danos, mesmo que indirectos,

resultantes de assistência técnica prestada por serviços não autorizados pela Polar Electro. Para obter

mais informações, consulte Garantia Limitada Internacional Polar.

Substituir as Pilhas

Para substituir as pilhas do computador de corrida, do transmissor e do sensor de passada* siga,

cuidadosamente, as instruções em Instalar a Pilha do Sensor de Passada. Todas as pilhas são

substituídas da mesma maneira.

Se preferir que seja a Polar a substituir a pilha, contacte um Centro de Assistência Polar autorizado. O

Centro testará o sensor depois de substituir a pilha.

O uso excessivo da luz de retroiluminação gasta a pilha do computador de corrida mais rapidamente.

Num ambiente frio o indicador de pilha fraca poderá ser exibido, mas é desactivado logo que voltar a

um ambiente mais quente. Para garantir a máxima duração da tampa da pilha, abra-a apenas quando

substituir a pilha. Quando substituir a pilha verifique se o anel vedante não está danificado; se for esse

o caso, substitua-o por um novo. Os conjuntos de pilhas com anéis vedantes estão disponíveis em

retalhistas Polar bem equipados e em Centros de Assistência Polar autorizados. Nos EUA e Canadá, os

anéis vedantes estão disponíveis apenas em Centros de Assistência Polar autorizados.

Mantenha as pilhas fora do alcance de crianças. Em caso de ingestão contacte imediatamente um médico.
As pilhas devem ser eliminadas de acordo com as leis locais.

Polar RS800 Manual do Utilizador 49

http://articles.polar.fi


*É necessário utilizar o sensor de passada s3 stride sensor W.I.N.D. vendido separadamente.

Precauções

Interferências Durante o Exercício

Interferências Electromagnéticas e Equipamento de Exercício.

Podem ocorrer interferências perto de linhas de alta tensão, semáforos, catenárias de comboios e de

eléctricos, televisões, motores de automóvel, computadores de bicicleta, de alguns aparelhos de

exercício motorizados, telemóveis ou quando passar em portas com sistemas de detecção de metais.

Os fornos de microondas, computadores e estações-base WLAN também podem provocar interferências

quando se estiver a exercitar com o RS800. Para evitar leituras irregulares, afaste-se de eventuais

fontes de interferências.

Os equipamentos de exercício com componentes electrónicos ou eléctricos, como visores de LED,

motores e travões eléctricos, podem provocar interferências. Para resolver estes problemas, proceda do

seguinte modo:

1. Retire o transmissor do peito e utilize o equipamento de exercício como habitualmente.

2. Desloque o computador de corrida até encontrar uma zona em que não seja exibida nenhuma

leitura errada nem o símbolo do coração intermitente. Regra geral, a interferência é maior mesmo

à frente do ecrã do equipamento, enquanto do lado esquerdo ou direito do ecrã é quase

inexistente.

3. Volte a colocar o transmissor no peito e, tanto quanto possível, mantenha o computador de corrida

nesta zona livre de interferências.

Se mesmo assim o computador de corrida não funcionar com o equipamento de exercício, este pode

emitir demasiado ruído eléctrico para permitir a medição da frequência cardíaca sem fios.

Utilizar o Computador de Corrida RS800 na Água

O computador de corrida é resistente à água. No entanto, a medição da frequência cardíaca não

funciona dentro de água. Pode usar o computador de corrida debaixo de água, como um relógio,

apesar de não se tratar de um instrumento de mergulho. Para preservar a resistência à água, não prima

os botões do computador de corrida debaixo de água. O uso do computador de corrida debaixo de

chuva intensa também pode causar interferências.

Minimizar Riscos Durante o Exercício

A prática de exercício pode incluir algum risco. Antes de iniciar um programa de exercício regular,

recomendamos que responda às seguintes perguntas sobre o seu estado de saúde. Se responder

afirmativamente a alguma destas perguntas, recomendamos que consulte um médico antes de iniciar

qualquer programa de treino.

• Deixou de praticar exercício durante os últimos 5 anos?

• Tem hipertensão ou colesterol elevado?

• Está a tomar algum medicamento para a tensão ou para o coração?

• Tem ou teve problemas respiratórios?

• Tem sintomas de alguma doença?

• Está a recuperar de doença grave ou de tratamento médico?

• Tem um pacemaker ou outro dispositivo electrónico implantado?

• Fuma?

• Está grávida?

Não se esqueça que, para além da intensidade do exercício, a medicação para o coração, para a

tensão arterial, para patologias do foro psicológico, para a asma, para problemas respiratórios, etc.,

bem como algumas bebidas energéticas, o álcool e a nicotina, também podem afectar a sua frequência

cardíaca.

É importante estar atento às reacções do seu organismo durante a actividade física. Se sentir alguma

dor inesperada ou fadiga excessiva durante o exercício, deve parar ou continuar com menos

intensidade.

Aviso para pessoas com pacemakers, desfibriladores ou outros dispositivos electrónicos implantados.

Os indivíduos com pacemaker que utilizem o computador de corrida Polar, fazem-no por sua conta e

risco. Antes de começar a utilizar, recomendamos sempre a realização de uma prova de esforço sob

supervisão médica. Esta prova destina-se a garantir a segurança e fiabilidade da utilização simultânea
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do pacemaker e do computador de corrida Polar.

Se tem alergia cutânea a alguma substância ou se suspeita de uma reacção alérgica provocada pela

utilização do produto, consulte a lista de materiais apresentada nas Especificações Técnicas. Para

evitar qualquer risco de reacção cutânea ao transmissor, use-o por cima de uma T-shirt, mas

humedeça-a bem por baixo dos eléctrodos para garantir um funcionamento sem problemas.

A sua segurança é importante para nós. O formato do sensor de pé/sensor de passada* foi concebido

para minimizar a possibildade de ficar preso a qualquer coisa. Mesmo assim, tenha cuidado quando

correr com o sensor de pé/sensor de passada no meio do mato, por exemplo.

A humidade e o desgaste intensos podem provocar a libertação de tinta preta da superfície do
transmissor, que pode manchar roupas claras. Se utilizar repelente de insectos, evite o contacto com o
transmissor.

*É necessário utilizar o sensor de passada s3 stride sensor W.I.N.D. vendido separadamente.

Perguntas Mais Frequentes

O que devo fazer se...

...visualizar o símbolo de pilha fraca e a mensagem Battery low (Pilha fraca)?

Normalmente, o primeiro sinal de que a pilha está sem carga é o aparecimento do indicador de pilha

fraca no visor. No entanto, num ambiente frio, o indicador de pilha fraca pode ser exibido. O indicador

deixa de ser exibido logo que voltar a um ambiente com uma temperatura normal. Quando o símbolo é

exibido, os sinais sonoros e a retroiluminação do computador de corrida são automaticamente

desactivados. Para obter mais informações sobre a substituição da pilha, consulte Cuidados e

Manutenção.

...não souber onde estou no menu?

Prima STOP sem libertar, até ser exibida a hora.

...não acontecer nada quando carrego nos botões?

Reinicialize o computador de corrida premindo todos os botões simultaneamente durante dois

segundos, até o visor ficar cheio de dígitos. Prima um botão qualquer e defina a hora e a data nas

Definições Básicas. Todas as outras definições permanecem guardadas. Ignore as restantes definições

premindo STOP, sem libertar.

...o valor da frequência cardíaca for irregular, extremamente elevado ou nulo (00)?

• Certifique-se de que o computador de corrida não está a mais de 1 m / 3 pés do transmissor.

• Certifique-se de que a tira do transmissor não ficou frouxa durante o exercício.

• Certifique-se de que os eléctrodos do material têxtil do equipamento de desporto ficam justos à

pele.

• Certifique-se de que os eléctrodos do transmissor/vestuário desportivo estão humedecidos.

• Certifique-se de que o transmissor/vestuário desportivo está limpo.

• Certifique-se de que não existe nenhum transmissor de frequência cardíaca num raio de 1 m / 3

pés.

• Os sinais electromagnéticos fortes podem causar leituras irregulares. Para obter mais informações,

consulte Precauções.

• Se a frequência cardíaca continuar irregular, apesar de se afastar da fonte de interferências,

diminua a velocidade e verifique o pulso manualmente. Se achar que corresponde aos valores

elevados exibidos no visor, poderá ter uma arritmia cardíaca. A maioria dos casos de arritmia não é

grave, mas mesmo assim consulte o seu médico.

• Poderá ter ocorrido um problema cardíaco que tenha alterado o seu ECG. Se for esse o caso,

consulte o seu médico.

…for exibida a mensagem Memory full (memória cheia)?

A mensagem é exibida durante o exercício se tiver gravado 99 voltas ou se não houver memória livre

para gravar o exercício. Nesse caso interrompa a gravação do exercício e transfira os ficheiros do

exercício do computador de corrida para o Polar ProTrainer 5. Depois, apague-os do computador de

corrida.
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…visualizar a indicação Check WearLink! (Verificar WearLink!) e o computador de corrida não conseguir

captar o sinal da frequência cardíaca?

• Certifique-se de que o computador de corrida não está a mais de 1 m / 3 pés do transmissor.

• Certifique-se de que a tira do transmissor não ficou frouxa durante o exercício.

• Certifique-se de que os eléctrodos do material têxtil do vestuário desportivo ficam justos à pele.

• Certifique-se de que os eléctrodos do transmissor/vestuário desportivo estão humedecidos.

• Certifique-se de que o transmissor / eléctrodos do vestuário desportivo estão limpos e não estão

danificados.

• Se não for possível determinar a frequência cardíaca quando usar o vestuário desportivo, tente usar

uma tira WearLink. Se a frequência cardíaca for detectada com a tira, é provável que o problema

esteja no vestuário. Contacte o retalhista/fabricante do equipamento de desporto.

• Se seguiu todas as orientações anteriormente referidas, mas continua a visualizar a mensagem e a

determinação da frequência cardíaca não funciona, é possível que a pilha do transmissor esteja

esgotada. Para mais informações, consulte Cuidados e Manutenção.

...visualizar a mensagem New WearLink found. Teach new WearLink? (Foi encontrado um novo Novo

WearLink. Ensinar o novo WearLink?).

Se adquiriu um novo sensor de passada como acessório terá de o apresentar ao computador de corrida.

Para obter mais informações, consulte Ensinar um Novo Transmissor.

Se o transmissor que está a usar veio incluído no produto e o texto aparece no visor o computador de

corrida poderá estar a detectar o sinal de um outro transmissor. Nesse caso assegure-se de que está a

usar o seu próprio transmissor, que os eléctrodos estão humedecidos e que o cinto do transmissor não

está frouxo. Se a mensagem continuar a aparecer, a pilha do seu transmissor está gasta. Para mais

informações, consulte Cuidados e Manutenção.

...visualizar a indicação Check S sensor! (Verifique o sensor de Passada!) e não for possível captar os

sinais da velocidade e da distância?*

• Verifique se a função sensor de pé está activada no computador de corrida. Nesse caso deve

visualizar o símbolo do corredor no computador de corrida.

• Se mantiver o computador de corrida à sua frente durante mais de 15 segundos, as medições da

velocidade e da distância são interrompidas. Desloque a mão para reactivar as medições.

• Se estiver a correr num tapete rolante e o computador de corrida estiver colocado numa barra à sua

frente, tente mover o computador de corrida para o lado.

• Assegure-se de que o sensor de passada está posicionado correctamente.

• A pilha do seu sensor de passada poderá estar gasta. Para mais informações, consulte Cuidados e

Manutenção.

...visualizar a indicação S sensor calibration failed (Falha na calibração do sensor de Passada)?*

A calibração não foi bem sucedida e necessita de ser efectuada novamente. A calibração falha se

efectuar movimentos durante a mesma. Assim que atingir a distância da volta pare de correr e fique

imóvel para permitir a calibração. O intervalo de medição do factor de calibração durante a calibração

manual é de 0,500-1,500. Se tiver definido o factor de calibração abaixo ou acima destes valores, a

calibração falha.

…visualizar a pergunta Teach new sensor? (Ensinar um novo sensor?)*

Se adquiriu um novo sensor de passada como acessório terá de ser apresentado ao computador de

corrida. Para obter mais informações, consulte Ensinar um Novo Sensor de Passada .

Se o sensor de passada que está a usar veio incluído no produto e o texto é exibido no visor, o

computador de corrida poderá estar a detectar o sinal de um outro transmissor. Nesse caso,

assegure-se de que está a usar o seu próprio sensor. Se a mensagem continuar a aparecer, a pilha do

seu sensor está gasta. Para mais informações, consulte Cuidados e Manutenção.

...visualizar a indicação Too many S sensors nearby (Demasiados sensores de Passada nas

proximidades)?*

Foi captado mais de um sinal durante um processo de aprendizagem. O computador de corrida só

pode receber sinais de um sensor de passada de cada vez. O computador de corrida continua a

procurar até detectar apenas um sinal. Assegure-se de que não está perto (20 metros/66 ft) de outros

sensores de passada.
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... a altitude continuar a mudar embora não me esteja a deslocar

O computador de corrida converte a pressão atmosférica num valor de altitude. É por este motivo que

as alterações do tempo podem provocar mudanças nas leituras da altitude.

…as leituras da altitude estiverem incorrectas?

Se o altímetro for exposto a interferências externas, como ventos fortes ou aparelhos de ar

condicionado, poderá exibir leituras incorrectas. Neste caso, tente calibrar o altímetro. Se as leituras

se mantiverem incorrectas, os canais de medição da pressão podem estar sujos. Neste caso, envie o

computador de corrida a um Centro de Assistência Técnica Polar.

...visualizar a mensagem Memory low (Memória fraca)?

Esta mensagem é apresentada quando existir cerca de 1 hora de memória disponível. Para maximizar

a capacidade da memória que resta, seleccione a Frequência de Gravação mais baixa (60 sec) em

Settings > Features > Rec.rate (Definições > Características > Frequência de Gravação). Depois de

esgotada a memória, é apresentada a indicação Memory full (Memória cheia). Para libertar memória

transfira os exercícios para o software Polar Pro Trainer 5 e elimine-os da memória da unidade de

pulso.

*É necessário utilizar o sensor de passada s3 stride sensor W.I.N.D. vendido separadamente.

Especificações Técnicas

Unidade de pulso

A unidade de pulso é um produto laser

da Classe 1.

Duração da pilha: Em média 1 ano (1h/ dia, 7 dias/ semana)

Tipo de pilha: CR2032

Anel vedante da pilha: Anel vedante 20,0 x 1,0; material: silicone

Temperatura de funcionamento: -10 °C a +50 °C / 14 °F a 122 °F

Material do bracelete e da fivela: Poliuretano, aço inoxidável

Tampa posterior: Poliamida, aço inoxidável conforme à Directiva 94/27/EU e

suas alterações 1999/C 205/05 sobre a libertação de níquel

a partir de produtos destinados a entrar em contacto directo

e prolongado com a pele.

Precisão do relógio: Superior a ± 0,5 segundos / dia a uma temperatura de 25 °C

/ 77 °F

Precisão do monitor da frequência

cardíaca:

± 1% ou 1 bpm, consoante o maior. A definição aplica-se a

condições de estabilidade.

Intervalo da medição da frequência

cardíaca:

15-240

Intervalo de visualização da velocidade

actual:

Sensor de passada: 0-36 km/h ou 0-22,3 mph

Intervalo de visualização da altitude: -550 m … +9000 m / -1800 ft … +29500 ft

A unidade de pulso Polar calcula a altitude através da

altitude média padrão a determinadas pressões

atmosféricas, de acordo com a ISO 2533

Resolução da subida: 5 m / 20 ft

Valores limites da unidade de pulso

Máximo de ficheiros: 99

Tempo máximo: 99 h 59 min 59 s

Máximo de voltas: 99

Distância total percorrida com os

sapatos 1:

999 999 km / 621370 mi
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Distância total percorrida com os

sapatos 2:

999 999 km / 621370 mi

Distância total: 999 999 km / 621370 mi

Duração total: 9999h 59min 59s

Consumo calórico total: 999 999 kcal

Total da contagem das sessões de

exercício:

9999

Total subido: 304795 m / 999980 ft

Transmissor

Duração da pilha do WearLink W.I.N.D.

Transmissor

Média de 2 anos (3h/ dia, 7 dias/ semana)

Tipo de pilha: CR2025

Anel vedante da pilha: Anel vedante 20,0 x 1,0; Material: FPM

Temperatura de funcionamento: -10 °C a +40 °C / 14 °F a 104 °F

Material do conector: Poliamida

Material da tira elástica: Poliuretano/ Poliamida/ Poliéster/ Elastano/ Nylon

Sensor de Passada

Duração da pilha: Em média 50 horas de utilização

Tipo de pilha: CR2430

Anel vedante da pilha: Anel vedante 25,0 x 1,0; material: silicone

Temperatura de funcionamento: -10 °C a +50 °C / 14 °F a 122 °F

Precisão: ±3 % ou superior, após calibração, sendo a definição

aplicável a condições de estabilidade

Polar WebLink Polar com Comunicação IrDA, Polar ProTrainer 5™

Requisitos Do Sistema: PC

Windows® 98/98SE/ME/2000/XP

Porta compatível com IrDA (dispositivo externo IrDA ou porta

interna IR)

Além disso, para correr o software, o PC deverá ter um

processador Pentium II 200 MHz ou superior, monitor com

resolução SVGA ou superior, 50 MB de espaço livre no disco

rígido e unidade de CD-ROM.

O computador de corrida Polar indica o nível de esforço fisiológico e a intensidade do exercício. Exibe

indicadores de desempenho e condições ambientais, como a altitude e a temperatura. Se for utilizado

com o sensor de pé S1, também mede a velocidade e a distância, e quando usado com o sensor de

passada s3, mede o ritmo da corrida. Não se destina nem está implícito nenhum outro tipo de

utilização.

O Computador de corrida Polar não deve ser utilizado para calcular parâmetros ambientais que exijam

rigor profissional ou industrial. Além disso, não deve utilizá-lo para efectuar leituras se estiver a

praticar actividades aéreas ou subaquáticas.

A resistência dos produtos Polar à água é testada em conformidade com a Norma Internacional ISO

2281. Os produtos são divididos em três categorias diferentes, conforme a sua resistência à água.

Verifique a inscrição referente à categoria de resistência à água, na parte de trás do seu produto Polar,

e confira as respectivas características no quadro apresentado a seguir. Não se esqueça que estas

definições não se aplicam necessariamente a produtos de outros fabricantes.
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Inscrição na parte de trás da caixa Salpicos,

suor,

chuva, etc.

Tomar

banho e

nadar

Mergulho

em apneia

(sem

garrafas de

ar)

Mergulho

autónomo

(com

garrafas de

ar)

Características de

resistência à água

Water resistant
x Salpicos, chuva,

etc.

Water resistant 50m
x x Mínimo para

tomar banho e

nadar*.

Water resistant 100m
x x x Para uso

frequente na

água mas não

para mergulho

autónomo.

*Estas características também se aplicam aos transmissores Polar WearLink 31 e ao Polar WearLink

W.I.N.D., que apresenta a inscrição Water resistant 30 m.

Garantia Limitada Internacional Polar

• Esta garantia limitada internacional Polar é emitida pela Polar Electro Inc. em nome dos clientes

que adquiriram este produto nos EUA ou Canadá. Esta garantia limitada internacional Polar é

emitida pela Polar Electro Oy em nome dos clientes que adquiriram este produto noutros países.

• A Polar Electro Oy/Polar Electro Inc. garante ao consumidor/comprador original deste dispositivo,

que o produto se encontra livre de defeitos de material e de mão-de-obra, por um período de dois

anos a contar da data de aquisição.

• Agradecemos que guarde o recibo ou o Cartão de Assistência a Clientes Polar carimbado, que

constitui a sua prova de compra!

• A garantia não cobre a pilha, danos devidos a uso inadequado ou abusivo, acidentes,

incumprimento das precauções, manutenção inadequada, uso comercial, caixas rachadas ou

destruídas e a tira elástica.

• A garantia não cobre quaisquer danos, perdas, custos ou despesas, directas, indirectas, acidentais,

consequentes ou especiais, resultantes ou relacionadas com o produto. Durante o período de

garantia o produto será reparado ou substituído, num Centro de Assistência Técnica autorizado,

sem quaisquer encargos.

• Esta garantia não afecta os direitos estatutários do consumidor, consagrados nas leis nacionais ou

estaduais em vigor, ou os direitos do consumidor em relação ao retalhista, decorrentes do

respectivo contrato de venda/compra.

Este produto está conforme às Directivas 93/42/EEC e 1999/5/EC. A respectiva Declaração de

Conformidade está disponível em www.support.polar.fi/declaration_of_conformity.html.

O símbolo do caixote do lixo com rodas com uma cruz sobreposta indica que os produtos Polar são

dispositivos electrónicos abrangidos pela Directiva 2002/96/EC do Parlamento Europeu e do Conselho,

relativa a resíduos de equipamentos eléctricos e electrónicos (REEE). Por isso, nos países da UE, estes

produtos devem ser eliminados selectivamente. Fora da União Europeia, a Polar encoraja-o a

minimizar eventuais efeitos dos resíduos no ambiente e na saúde humana, seguindo as leis locais

referentes à eliminação de resíduos e, sempre que possível, a utilizar uma recolha selectiva dos

dispositivos electrónicos.

Copyright © 2006 Polar Electro Oy, FIN-90440 KEMPELE, Finlândia.

A Polar Electro Oy é uma empresa com certificação ISO 9001:2000.

Todos os direitos reservados. Nenhuma parte deste manual pode ser utilizada ou reproduzida, seja de

que forma for e por que meio for, sem o consentimento prévio por escrito da Polar Electro Oy. Os
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nomes e logotipos assinalados neste manual do utilizador ou na embalagem do produto com um

símbolo ™, são marcas comerciais da Polar Electro Oy. Os nomes e logotipos assinalados neste

manual do utilizador ou na embalagem do produto com um símbolo ®, são marcas registadas da Polar

Electro Oy, excepto Windows, que é uma marca registada da Microsoft Corporation.

Termo de responsabilidade da POLAR

• O conteúdo deste manual destina-se apenas a fins informativos. Devido ao programa de

desenvolvimento permanente do fabricante, os produtos aqui descritos estão sujeitos a alterações

sem aviso prévio.

• A Polar Electro Inc./Polar Electro Oy não faz quaisquer representações nem fornece garantias em

relação a este manual, ou em relação aos produtos aqui descritos.

• A Polar Electro Inc./Polar Electro Oy não se responsabiliza por quaisquer danos, perdas, custos ou

despesas, directas, indirectas, acidentais, consequentes ou especiais, decorrentes de, ou referentes

ao uso deste material ou dos produtos aqui descritos.

Este produto está protegido por uma ou mais das seguintes patentes: US 5486818, GB 2258587, HK

306/1996, WO96/20640, EP 0748185, US6104947, EP 0747003, US5690119, DE

69630834,7-08, WO 97/33512, US 6277080, EP 0984719, US 6361502, EP 1405594, US

6418394, EP 1124483, US 6405077, US 6714812, US 6537227, FI 114202, US 6666562 B2,

US 5719825, US 5848027, EP 1055158, FI 113614, FI23471, USD49278S, USD492784S,

USD492999S, FI68734, US4625733, DE3439238, GB2149514, HK81289, FI88972,

US5486818, DE9219139.8, GB2258587, FR2681493, HK306/1996, FI96380, WO95/05578,

EP665947, US5611346, JP3568954, DE69414362, FI4150, US6477397, DE20008882,

FR2793672, ES1047774, FI112844, EP 724859 B1, US 5628324, DE 69600098T2, FI110915.

Outras patentes pendentes.

Fabricado por:

Polar Electro Oy

Professorintie 5

FIN-90440 KEMPELE

Tel +358 8 5202 100

Fax +358 8 5202 300

www.polar.fi

17931464.00 PRT A
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